
x

Анализаторы спектра в реальном масштабе времени серии
SPECMON3
Анализаторы спектра в реальном масштабе времени серии
SPECMON6
ZZZ

Руководство по эксплуатации

*P071307000*

071-3070-00





Анализаторы спектра в реальном масштабе времени серии
SPECMON3
Анализаторы спектра в реальном масштабе времени серии
SPECMON6
ZZZ

Руководство по эксплуатации

xx

www.tektronix.com
071-3070-00



Copyright © Tektronix. Все права защищены. Лицензированные программные продукты являются собственностью компании
Tektronix, ее филиалов или ее поставщиков и защищены национальным законодательством по авторскому праву и
международными соглашениями.

Изделия корпорации Tektronix защищены патентами и патентными заявками в США и других странах. Приведенные в данном
руководстве сведения заменяют любые ранее опубликованные. Права на изменение спецификаций и цен сохранены.

TEKTRONIX и TEK являются зарегистрированными товарными знаками Tektronix, Inc.

Как связаться с корпорацией Tektronix

Tektronix, Inc.
14150 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Сведения о продуктах, продажах, услугах и технической поддержке.
В странах Северной Америки по телефону 1-800-833-9200.
В других странах мира — см. сведения о контактах для соответствующих регионов на веб-узле www.tektronix.com.



Гарантия

Корпорация Tektronix гарантирует, что в данном продукте не будут обнаружены дефекты материалов и изготовления в течение
1 (одного) года со дня поставки. Если в течение гарантийного срока в таком изделии будут обнаружены дефекты, корпорация
Tektronix, по своему выбору, либо устранит неисправность в дефектном изделии без дополнительной оплаты за материалы и
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Для реализации своего права на обслуживание в соответствии с данной гарантией необходимо до истечения гарантийного
срока уведомить корпорацию Tektronix об обнаружении дефекта и выполнить необходимые для проведения гарантийного
обслуживания действия. Ответственность за упаковку и доставку неисправного изделия в центр гарантийного обслуживания
корпорации Tektronix, а также предоплата транспортных услуг возлагается на владельца. Корпорация Tektronix оплачивает
обратную доставку исправного изделия заказчику только в пределах страны, в которой расположен центр гарантийного
обслуживания. Доставка исправного изделия по любому другому адресу должна быть оплачена владельцем изделия,
включая все расходы по транспортировке, пошлины, налоги и любые другие расходы.

Данная гарантия перестает действовать в том случае, если дефект, отказ в работе или повреждение изделия вызваны
неправильным использованием, хранением или обслуживанием изделия. В соответствии с данной гарантией корпорация
Tektronix не обязана: а) исправлять повреждения, вызванные действиями каких-либо лиц (кроме сотрудников Tektronix) по
установке, ремонту или обслуживанию изделия; б) исправлять повреждения, вызванные неправильной эксплуатацией
изделия или его подключением к несовместимому оборудованию; в) исправлять повреждения или неполадки, вызванные
использованием расходных материалов, отличных от рекомендованных корпорацией Tektronix; а также г) обслуживать
изделие, подвергшееся модификации или интегрированное с иным оборудованием таким образом, что это увеличило
время или сложность обслуживания изделия.
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Общие правила техники безопасности

Общие правила техники безопасности

Во избежание травм, а также повреждений данного изделия и подключаемого к нему оборудования необходимо
соблюдать следующие правила техники безопасности.

Используйте изделие в строгом соответствии с инструкциями, чтобы исключить фактор риска.

Процедуры по обслуживанию устройства могут выполняться только квалифицированным персоналом.

Во время работы с прибором может потребоваться доступ к другим компонентам системы. Прочтите разделы по
технике безопасности в руководствах по работе с другими компонентами и ознакомьтесь с мерами предосторожности
и предупреждениями, связанными с эксплуатацией системы.

Пожарная безопасность и предотвращение травм

Используйте соответствующий кабель питания. Подключение к электросети должно выполняться только
кабелем, разрешенным к использованию с данным изделием и сертифицированным для страны, в которой будет
производиться его эксплуатация.

Используйте защитное заземление. Прибор заземляется через провод защитного заземления шнура питания.
Во избежание поражения электрическим током соответствующий контакт кабеля питания должен быть заземлен.
Проверьте наличие защитного заземления, прежде чем выполнять подсоединение к выходам и входам прибора.

Соблюдайте ограничения на параметры разъемов. Во избежание воспламенения или поражения
электрическим током проверьте все допустимые номиналы и маркировку на приборе. Перед подсоединением
прибора просмотрите дополнительные сведения по номинальным ограничениям, содержащиеся в руководстве к
прибору.

Входы не предназначены для подключения к электросети и цепям категорий II, III или IV.

Отключение питания. Отсоедините шнур питания прибора от источника питания. Не следует перекрывать
подход к шнуру питания; он должен всегда оставаться доступным для пользователя.

Не используйте прибор с открытым корпусом. Использование прибора со снятым кожухом или защитными
панелями не допускается.

Не пользуйтесь неисправным прибором. Если имеется подозрение, что прибор поврежден, передайте его
для осмотра специалисту по техническому обслуживанию.

Избегайте прикосновений к оголенным участкам проводки. Не прикасайтесь к неизолированным
соединениям и компонентам, находящимся под напряжением.

Соблюдайте правила замены батареи. Используйте только батареи, типы и номиналы которых соответствуют
требованиям данного прибора.

Используйте соответствующий предохранитель. К применению допускаются только предохранители, типы
и номиналы которых соответствуют требованиям для данного прибора.

Не пользуйтесь прибором в условиях повышенной влажности.

Не пользуйтесь прибором во взрывоопасных средах.

Не допускайте попадания влаги и загрязнений на поверхность прибора.

Обеспечьте надлежащую вентиляцию. Дополнительные сведения по обеспечению надлежащей вентиляции
при установке изделия содержатся в руководстве.

SPECMON3 и SPECMON6 — краткое руководство по эксплуатации iii



Общие правила техники безопасности

Условные обозначения в данном руководстве

Ниже приводится список условных обозначений, используемых в данном руководстве.

ПРЕДУПРЕЖДЕНИЕ. Предупреждения о действиях и условиях, представляющих угрозу для жизни или способных
нанести вред здоровью.

ОСТОРОЖНО. Предостережения о действиях и условиях, способных привести к повреждению данного прибора
или другого оборудования.

Символы и условные обозначения в данном руководстве

Ниже приводится список возможных обозначений на изделии.

Обозначение DANGER (Опасно!) указывает на непосредственную опасность получения травмы.

Обозначение WARNING (Внимание!) указывает на возможность получения травмы при отсутствии
непосредственной опасности.

Обозначение CAUTION (Осторожно!) указывает на возможность повреждения данного изделия и другого
имущества.

Ниже приводится список символов на изделии.
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Информация о соответствии

В настоящем разделе приводятся стандарты электромагнитной совместимости, безопасности и природоохранные
стандарты, которым удовлетворяет данный прибор.

Соответствие требованиям стандартов по электромагнитной
совместимости

Заявление о соответствии стандартам EC – электромагнитная совместимость

Отвечает требованиям директивы 2004/108/EC по электромагнитной совместимости. Проверено на соответствие
перечисленным ниже стандартам (как указано в «Official Journal of the European Communities»):

EN 61326-1:2006, EN 61326-2-1:2006. Требования по электромагнитной совместимости электрооборудования
для измерений, контроля и использования в лабораториях. 1 2 3 4

CISPR 11:2003. Обычные и наведенные излучения, группа 1, класс A

IEC 61000-4-2:2001. Защищенность от электростатических разрядов

IEC 61000-4-3:2002. Защищенность от электромагнитных радиочастотных полей 5

IEC 61000-4-4:2004. Защищенность от перепадов и всплесков напряжения

IEC 61000-4-5:2001. Защищенность от скачков напряжения в сети питания

IEC 61000-4-6:2003. Защищенность от наведенных высокочастотных помех 6

IEC 61000-4-11:2004. Защищенность от понижения и пропадания напряжения в сети питания 7

EN 61000-3-2:2006. Гармонические излучения сети переменного тока

EN 61000-3-3:1995. Изменения напряжения, флуктуации и фликкер-шум

Контактный адрес в Европе.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
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Великобритания

1 Прибор предназначен для использования только в нежилых помещениях. При использовании в жилых помещениях
могут возникнуть электромагнитные помехи.

2 При подключении оборудования к тестируемому объекту могут появиться излучения, превышающие уровни,
установленные данными стандартами.

3 Соответствие перечисленным стандартам гарантируется только при использовании высококачественных экранированных
кабелей.

4 В процессе выполнения теста на устойчивость к переходному режиму путем прерывания напряжения до 0 % на 250 циклов
в соответствии со стандартом IEC 61000-4-11 проверяемое оборудование перезагружается, и на его восстановление может
потребоваться более 10 секунд.

5 Информация об ухудшении характеристик при выполнении теста IEC 61000-4-3: Остаточные паразитные сигналы могут
достигать –55 дБм при воздействиях до уровней помех для данного испытания.

6 Информация об ухудшении характеристик при выполнении теста IEC 61000-4-6: Остаточные паразитные сигналы, как
правило, могут возрастать до худшего из двух состояний – либо до 55 дБ ниже уровня опорного сигнала, либо до –75 дБм,
воздействуя на уровни помех в ходе данной проверки.

7 Критерий эффективности C применялся для тестовых уровней понижения напряжения до 70 %/25 циклов и прерывания
напряжения до 0 %/250 циклов (IEC 61000-4-11).

Заявление о соответствии стандартам для Австралии/Новой Зеландии – электромагнитная
совместимость

Соответствует следующему стандарту электромагнитной совместимости для радиокоммуникаций в соответствии с
ACMA:

CISPR 11:2003. Обычные и наведенные излучения, группа 1, класс A, в соответствии с EN 61326-1:2006 и
EN 61326-2-1:2006.

Контактный адрес в Австралии/Новой Зеландии:

Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

Соответствие нормам безопасности
Заявление о соответствии стандартам EC – низковольтное оборудование

Проверено на соответствие перечисленным ниже спецификациям (как указано в «Official Journal of the European
Communities»):

Директива 2006/95/EC по низковольтному оборудованию.
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EN 61010-1: 2001. Требования по безопасности электрооборудования для измерений, контроля и использования
в лабораториях.

Номенклатура разрешенного в США тестового оборудования для применения в
лабораториях

UL 61010-1:2004, 2-я редакция. Стандарт на электрическое измерительное и испытательное оборудование.

Сертификат для Канады

CAN/CSA-C22.2 No. 61010-1:2004. Требования по безопасности электрооборудования для измерений, контроля
и использования в лабораториях. Часть 1.

Дополнительные стандарты

IEC 61010-1: 2001. Требования по безопасности электрооборудования для измерений, контроля и
использования в лабораториях.

Тип оборудования

Тестовое и измерительное оборудование.

Класс безопасности

Класс 1 – заземленный прибор.

Описание уровней загрязнения

Степень загрязнения, фиксируемого вблизи прибора и внутри него. Обычно считается, что параметры среды внутри
прибора те же, что и снаружи. Прибор должен использоваться только в среде, параметры которой подходят для
его эксплуатации.

Уровень загрязнения 1. Загрязнение отсутствует, или встречается загрязнение только сухими непроводящими
материалами. Приборы данной категории обычно эксплуатируются в герметичном, опечатанном исполнении или
устанавливаются в помещениях с очищенным воздухом.

Уровень загрязнения 2. Обычно встречается загрязнение только сухими непроводящими материалами. Иногда
может наблюдаться временная проводимость, вызванная конденсацией. Такие условия типичны для жилого или
рабочего помещения. Временная конденсация наблюдается только в тех случаях, когда прибор не работает.

Уровень загрязнения 3. Загрязнение проводящими материалами или сухими непроводящими материалами,
которые становятся проводящими из-за конденсации. Это характерно для закрытых помещений, в которых не
ведется контроль температуры и влажности. Место защищено от прямых солнечных лучей, дождя и ветра.

Уровень загрязнения 4. Загрязнение, приводящее к дополнительной проводимости из-за проводящей пыли,
дождя или снега. Типичные условия вне помещения.
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Уровень загрязнения

Уровень загрязнения 2 (в соответствии со стандартом IEC 61010-1). Примечание. Прибор предназначен только
для использования в помещении.

Защита окружающей среды
В этом разделе содержатся сведения о влиянии прибора на окружающую среду.

Утилизация прибора по окончании срока службы

При утилизации прибора и его компонентов необходимо соблюдать следующие правила:

Утилизация оборудования. Для производства этого прибора потребовалось извлечение и использование
природных ресурсов. Прибор может содержать вещества, опасные для окружающей среды и здоровья людей
в случае его неправильной утилизации. Во избежание утечки подобных веществ в окружающую среду и для
сокращения расхода природных ресурсов рекомендуется утилизировать данный прибор таким образом, чтобы
обеспечить максимально полное повторное использование материалов.

Этот символ означает, что данный прибор соответствует требованиям Европейского Союза согласно
директивам 2002/96/EC и 2006/66/EC об утилизации электрического и электронного оборудования
(WEEE) и элементов питания. Сведения об условиях утилизации см. в разделе технической поддержки
на веб-сайте Tektronix (www.tektronix.com).

Материалы, содержащие перхлорат. Этот продукт содержит плоские круглые литиевые аккумуляторы типа
CR. В соответствии с законодательством штата Калифорния плоские круглые литиевые аккумуляторы типа CR
входят в список материалов, содержащих перхлорат и требующих особого обращения. Дополнительные сведения
см. на странице www.dtsc.ca.gov/hazardouswaste/perchlorate.

Ограничение распространения опасных веществ

Прибор относится к контрольно-измерительному оборудованию и не подпадает под действие директивы 2002/95/EC
RoHS.
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Предисловие

В этом руководстве описаны установка и основные принципы работы анализаторов спектра в реальном масштабе
времени серии SPECMON3 и SPECMON6. Дополнительные сведения см. в интерактивной справке вашего прибора.

SPECMON3

SPECMON6

Основные характеристики
Передовые технологии анализа в реальном масштабе времени помогают решить самые сложные проблемы,
связанные с помехами в переходном режиме.

Уникальная функция Swept DPX позволяет выполнять сканирование в реальном времени всего диапазона частот
3—6,2 ГГц для обнаружения помех в переходном режиме (опция 200).

Полоса пропускания до 110 МГц для обнаружения и регистрации сигнала включения.

Лучшая в своем классе способность обнаружения и регистрации сигналов длительностью всего 3,7 мкс со
100 % вероятностью перехвата (POI) (опция 200).

Запатентованные технологии синхронизации по плотности DPX (опция 200), синхронизации по частотной маске
(опция 52) и расширенной синхронизации позволяют регистрировать сигналы длительностью всего 3,7 мкс в
частотной области и 9,1 нс во временной области.

Универсальная конструкция сокращает общие затраты на покупку и эксплуатацию за счет снижения стоимости
приобретения и годовых затрат на техническое обслуживание.

Встроенная функция привязки к карте позволяет выполнять как ручное, так и автоматическое пробное
тестирование (стандартная функция). Поддержка серийных GPS-приемников производства других компаний при
подключении через USB или Bluetooth.

Благодаря стандартному набору функций работу по анализу импульсов можно выполнять непосредственно на
объекте (таком, например, как радар аэропорта) автоматически и предельно просто.

Большой объем памяти данных анализа в реальном времени упрощают задачу продолжительного отслеживания
сигнала (стандартная комплектация и опция 53). При работе с расширенными функциями синхронизации
(опция 200) система повышает эффективность последующего анализа данных в 10 раз. Это позволяет
отказаться от использования отдельного устройства записи данных за счет возможности хранения спектрограмм
DPX/ниспадающих диаграмм (опция 53) продолжительностью до 12 лет или данных IQ продолжительностью
7 секунд при полосе пропускания 110 МГц (опция 110). Эта функция также сокращает время последующего
анализа только за счет синхронизации и сохранения нужного сигнала в соответствии с заданными пользователем
условиями синхронизации.

Передовая технология корреляции и анализа нескольких областей 3 в 1 сокращает количество необходимых
приборов для анализа временной и частотной областей, а также области модуляций.

Поддержка демодуляции для более 20 универсальных типов аналоговых и цифровых сигналов, в том числе
амплитудной и частотной демодуляции и гибкого анализа мультиплексирования с ортогональным частотным
разделением сигналов (OFDM).
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Обширные встроенные функции измерения поля, в том числе напряженности поля, интенсивности сигнала,
мощности в канале, тестирование электромагнитных помех, ослабления мощности по соседнему каналу,
занимаемой полосы частот и поиска побочного сигнала.

Стандартный предусилитель обеспечивает простые внешние соединения, а твердотельный жесткий диск
повышает надежность прибора.

Стандартная промышленная платформа снижает затраты на обучение работе с системой; открытый формат данных
повышает коэффициент использования оборудования за счет совместимости со стандартными промышленными
изделиями.

ОС Windows 7 Ultimate (64-разрядная) с поддержкой стандартной языковой локализации Microsoft.

Полученные IQ-данные можно сохранять в формате Matlab для использования в аналитических программных
средствах сторонних разработчиков.

Документация
С анализаторами спектра в реальном масштабе времени серии SPECMON3 и SPECMON6 поставляется приведенная
ниже документация. Самые последние редакции документации размещаются на веб-узле корпорации Tektronix.

Предмет Документы

Установка и эксплуатация
(обзоры)

Краткое руководство по эксплуатацииВ кратком руководстве по эксплуатации
содержится общая информация по вводу прибора в эксплуатацию и описание
элементов управления интерфейсом пользователя.

Подробные справочные
сведения об эксплуатации и
интерфейсе пользователя

Интерактивная справка
В интерактивной справке содержится подробная информация об эксплуатации
прибора.

Примеры применения Стандартные примеры примененияДанное руководство по эксплуатации содержит
примеры практического применения анализатора для выполнения различных задач.

Команды
программирования

Руководство программиста.Это руководство содержит описание команд
программирования и их использования. Данное руководство находится на
компакт-диске с документацией в формате PDF.

Технические
характеристики и проверка
эксплуатационных
параметров

Руководство по техническим характеристикам и проверке эксплуатационных
параметров
В этом руководстве по эксплуатации содержатся технические характеристики
прибора и процедуры проверки эксплуатационных параметров прибора для
сравнения с гарантируемыми характеристиками. Данное руководство по
эксплуатации находится на компакт-диске с документацией в формате PDF.

Обслуживание,
выполняемое
пользователем

Руководство по обслуживанию.Руководство, в котором приводится перечень
запасных частей, сведения по уходу и техническому обслуживанию и информация
по ремонту прибора на уровне модуля. Данное руководство находится на
компакт-диске с документацией в формате PDF.

x SPECMON3 и SPECMON6 — краткое руководство по эксплуатации



Предисловие

Обновления программного обеспечения
Имеется возможность обновлять дополнительное программное обеспечение. Обновления дополнительного
программного обеспечения вступают в силу только после ввода правильного ключа опции для конкретной модели
анализатора и серийного номера.

Чтобы проверить необходимость обновления:

1. При помощи своего веб-обозревателя зайдите на веб-сайт www.tektronix.com/software.

2. Введите название изделия (например, SPECMON3 или SPECMON6), чтобы проверить наличие обновлений
программного обеспечения.

Правила оформления, используемые в данном руководстве
В данном руководстве используются следующие значки.

Одно из
последова-
тельных
действий

Выключат-
ель питания
на передней
панели

Подключе-
ние электро-
питания

Сеть PS2 SVGA USB
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Установка

Перед установкой
Распакуйте прибор и сверьте с комплектностью, приведенной в списке как Стандартные принадлежности. В этом
разделе также приведены дополнительные принадлежности и опции прибора. Самую свежую информацию вы
найдете на веб-узле корпорации Tektronix (www.tektronix.com).

Стандартные принадлежности
Для вашего прибора поставляются следующие принадлежности: краткое руководство пользователя (перечень
языков приведен ниже), руководство программиста (на компакт-диске), руководство по техническим характеристикам
и проверкам эксплуатационных параметров (на компакт-диске), инструкции по рассекречиванию и средствам
защиты (на компакт-диске), руководство по обслуживанию (на компакт-диске), шнур питания, адаптер BNC-N,
USB-клавиатура, USB-мышь и передняя крышка прибора.

Документация по прибору

Руководство SPECMON3 Real-Time Spectrum Analyzers and SPECMON6 Real-Time Spectrum Analyzers Quick Start
User Manual (Анализаторы спектра в реальном масштабе времени серий SPECMON3 и SPECMON6. Краткое
руководство по эксплуатации) имеется на следующих языках:

английский, номер по каталогу Tektronix 071-3064-XX;

китайский (упрощенное письмо), номер по каталогу Tektronix 071-3066-XX;

японский, номер по каталогу Tektronix 071-3068-XX;

русский, номер по каталогу Tektronix 071-3070-XX.

Руководство SPECMON3 Real-Time Spectrum Analyzers and SPECMON6 Real-Time Spectrum Analyzers Application
Examples Manual (Стандартные примеры применения анализаторов спектра в реальном масштабе времени
серии SPECMON3 и SPECMON6) имеется на следующих языках:

английский, номер по каталогу Tektronix 071-3065-XX;

китайский (упрощенное письмо), номер по каталогу Tektronix 071-3067-XX;

японский, номер по каталогу Tektronix 071-3069-XX;

русский, номер по каталогу Tektronix 071-3071-XX.

SPECMON3 and SPECMON6 Product Documentation CD (компакт-диск с документацией по продукту для прибора
серии SPECMON3 и SPECMON6), номер по каталогу Tektronix 063-4468-XX.

Компакт-диск с документацией по продукту содержит версии в формате PDF следующих руководств:

SPECMON3 Real-Time Spectrum Analyzers and SPECMON6 Real-Time Signal Analyzers Quick Start User Manual
(Анализаторы спектра в реальном масштабе времени серий SPECMON3 и SPECMON6. Краткое руководство
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по эксплуатации),
на английском, русском, упрощенном китайском и японском языках.

SPECMON3 Real-Time Spectrum Analyzers and SPECMON6 Real-Time Signal Analyzers Application Examples
Manual (Стандартные примеры применения анализаторов спектра в реальном масштабе времени серии
SPECMON3 и SPECMON6), на английском, русском, упрощенном китайском и японском языках.

SPECMON3 Real-Time Spectrum Analyzers and SPECMON6 Real-Time Spectrum Analyzers Printable Online Help
(Анализаторы сигнала в реальном масштабе времени серии SPECMON3 и SPECMON6. Печатная версия
интерактивной справки),
номер по каталогу Tektronix 077-0740-XX.

SPECMON3 Real-Time Spectrum Analyzers and SPECMON6 Real-Time Spectrum Analyzers Programmer Manual
(Руководство по программированию анализаторов спектра в реальном масштабе времени серии SPECMON3
и SPECMON6.),
номер по каталогу Tektronix 077-0741-XX.

SPECMON3 and SPECMON6 Real-Time Spectrum Analyzers Service Manual (Анализаторы спектра в реальном
масштабе времени серии SPECMON3 и SPECMON6),
номер по каталогу 077-0754-XX.

SPECMON3 and SPECMON6 Real-Time Spectrum Analyzers Specifications and Performance Verification Manual
(Анализаторы спектра в реальном масштабе времени серии SPECMON3 и SPECMON6. Руководство по
техническим характеристикам и проверке эксплуатационных параметров),
номер по каталогу Tektronix 077-0742-XX.

SPECMON3 and SPECMON6 Real-Time Spectrum Analyzers Declassification and Security Instructions
(Анализаторы спектра в реальном масштабе времени серии SPECMON3 и SPECMON6. Инструкции по
рассекречиванию и безопасности),
номер по каталогу Tektronix 077-0754-XX.

Шнуры питания

Анализатор поставляется с одной из приведенных ниже опций шнура питания. Предназначенные для США
шнуры питания включаются в перечень UL и имеют сертификат CSA. Шнуры питания, предназначенные для
других регионов, проходят утверждение, по крайней мере, в одном из агентств, признаваемых страной, в которую
поставляется изделие.

Разъемы электропитания, используемые в разных странах

Опция A0 – для сетей питания Северной Америки.

Опция A1 – для сетей питания Европы, универсальный.

Опция A2 – для сетей питания Великобритании.

Опция A3 – для сетей питания Австралии.

Опция A4 – для сетей питания Северной Америки с напряжением 240 В.

Опция A5 – для сетей питания Швейцарии.

Опция A6 – для сетей питания Японии.

Опция A10 – для сетей питания Китая.

Опция A11 – для сетей питания Индии.
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Опция A12 – для сетей питания Бразилии

Опция A99 – без шнура питания.

Дополнительные принадлежности
SPECMON3 и SPECMON6

RTPA2A – Адаптер пробника анализатора спектра в реальном масштабе времени; поддерживает пробники
TekConnect P7225, P7240, P7260, P7330, P7313, P7350, P7350SMA, P7380, P7380SMA.

RSAVu – Программное обеспечение для автономного выполнения анализа на базе платформы RSA3000 для
анализа, поддерживающее стандарты беспроводной связи 3G, WLAN (IEEE 802.11a/b/g/n).

065-0852-XX: дополнительный съемный жесткий диск для использования с опцией 56 (операционная система
Windows 7 и программное обеспечение прибора предустановлены).

Транспортный контейнер – Номер по каталогу Tektronix 016-1963-00.

Опции
Для анализатора можно предусмотреть следующие опции:

Опция 10 — добавляется возможность аудиоанализа.

Опция 11 – добавляется измерение фазового шума и джиттера.

Опция 12 – добавляется измерение времени установления (частоты и фазы).

Опция 21 – добавляется общий анализ цифровой модуляции.

Опция 22 — добавляется гибкий анализ ортогонального частотного мультиплексирования (OFDM).

Опция 40 — полоса пропускания регистрации 40 МГц (только SPECMON3).

Опция 52 – добавляется синхронизация по частотной маске (Frequency Mask Triggering).

Опция 53 – добавляется память, в общей сложности 4 ГБ памяти выборки.

Опция 55 — цифровой вывод I и Q

Опция 110 — полоса пропускания регистрации 110 МГц.

Опция 200 – добавляется расширенный DPX с синхронизацией плотности, временных параметров и по
огибающей, а также временная развертка.

Условия эксплуатации
Требования к источнику питания

Напряжение и частота источника Потребляемая мощность

100 – 240 ВСКО, 50/60 Гц

115 ВСКО, 400 Гц

450 Вт максимум (все модели)
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Требования к окружающей среде

Характеристика Описание

Рабочая температура От 10 до 40 °C

Температура хранения От –20 до +60 °C

Влажность 90 % до 30 °C (без конденсации паров)Максимальная относительная
влажность 80 %, если необходим доступ к дисководу DVD-дисковВыше
30 °C ограничена максимальной температурой влажного термометра
29 °C

Высота над уровнем моря:

В рабочем состоянии

При хранении

До 3000 м

12190 м

Пространство для охлаждения

Снизу

Сбоку и сзади

20 мм

50 мм

ОСТОРОЖНО. Чтобы обеспечить правильное охлаждение, не устанавливайте при работе прибор на боковые
стороны. Работайте с прибором только тогда, когда он установлен на своих опорах, расположенных на нижней
стороне корпуса. Оставляйте не менее 5 см свободного пространства от вентиляционных отверстий.

ПРЕДУПРЕЖДЕНИЕ. Во избежание травмирования персонала при поднимании или перемещении анализатора
спектра предпринимайте дополнительные меры предосторожности. Прибор достаточно тяжел, для его
перемещения необходимо предпринять дополнительные меры предосторожности.
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Подключение к прибору
Подключение к компьютерной сети

Перед подключением к сети питания подсоедините клавиатуру, мышь, принтер и другие принадлежности к вашему
прибору. (Принадлежности с разъемами USB можно подсоединять к прибору как до, так и после включения питания.)

Чтобы обеспечить возможность печати,
предоставление общего доступа
к файлам, доступ в Интернет и
выполнение других коммуникационных
функций, можно подключить прибор
к компьютерной сети. Для настройки
сетевой конфигурации прибора
проконсультируйтесь со своим
администратором сети и воспользуйтесь
стандартными служебными программами
Windows.

Совет

При подключении прибора к компьютерной сети следует предпринять меры защиты прибора с помощью системы
защиты доступа в Интернет, установив рекомендуемые обновления операционной системы и используя
современное антивирусное программное обеспечение.

Включение прибора
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Выключение прибора

Обесточивание прибора
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Восстановление операционной системы
Файл восстановления операционной системы хранится в приборе в отдельном разделе жесткого диска.

Предпочтительным методом восстановления операционной системы прибора является использование файла
восстановления жесткого диска.

ОСТОРОЖНО. В процессе восстановления системы переформатируется жесткий диск и переустанавливается
операционная система. Все сохраненные ранее данные теряются. До начала восстановления системы, по
возможности, сохраните важные файлы на внешних носителях.

1. Перезапустите прибор. Во время процедуры перезагрузки в верхней части экрана появится следующее
сообщение: Starting Acronis Loader… press F5 for Acronis Startup Recovery Manager (Запускается загрузчик Acronis
Loader… для запуска диспетчера восстановления Acronis нажмите клавишу F5).

ПРИМЕЧАНИЕ. Для успешного восстановления системы необходимо использовать версию ПО Acronis для ОС
Windows. Использование типовой клавиатуры MAC приводит к запуску ПО Acronis версии DOS. Не пользуйтесь
клавиатурой MAC.

2. Несколько раз нажмите клавишу F5, пока не откроется программа Acronis True Image Tool. Обычно с момента
появления этого сообщения до того момента, когда продолжится нормальный запуск прибора, проходит 5
секунд. Если приложение Acronis не открывается, отключите питание прибора, затем снова включите питание и
повторите попытку.

3. Нажмите кнопку Restore (Восстановить).

4. В диалоговом окне Confirmation (Подтверждение) щелкните кнопку Yes (Да), чтобы восстановить операционную
систему прибора, или No (Нет), чтобы выйти из процесса восстановления. Процесс восстановления займет
примерно 30 минут. Фактическое время зависит от конфигурации прибора.
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Добавление внешнего монитора
Чтобы добавить внешний монитор для варианта работы с двумя мониторами, используйте следующую процедуру. И
на анализаторе и на втором мониторе следует установить цвет True Color.

1. Выключите анализатор и внешний
монитор.

2. Подсоедините внешний монитор к
анализатору.

3. Включите анализатор и внешний
монитор.
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4. Откройте Панель управления
Windows.

5. Дважды щелкнув пункт Intel(R)
Graphics and Media (графические
и аудиовизуальные средства
Intel(R)), откройте панель Intel
Graphics and Media Control Panel
(панель управления графическими и
аудиовизуальными средствами Intel).

6. Установите для параметра Display
(экран) значение Built-in Display
(встроенный экран).
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7. Нажмите кнопку Multiple Displays
(несколько экранов).

8. Задайте для параметра Operating
Mode (рабочий режим) значенияClone
Displays (размноженные экраны) или
Extended Displays (расширенные
экраны) по своему усмотрению.

9. При выборе Extended Desktop
(расширенный рабочий стол) не
забудьте установить значение
Positioning (положение), чтобы
выровнять друг относительно друга
два экрана рабочего стола.

Настройка параметров экрана Windows

Для изменения параметров экрана прибора вместо свойств экрана Windows по умолчанию используйте графический
драйвер Intel. Графический драйвер корпорации Intel предоставляет дополнительные возможности, которые не
доступны в диалоговом окне свойств экрана Windows.
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1. Откройте Панель управления
Windows.

2. Дважды щелкнув пункт Intel(R)
Graphics and Media (графические
и аудиовизуальные средства
Intel(R)), откройте панель Intel
Graphics and Media Control Panel
(панель управления графическими и
аудиовизуальными средствами Intel).

3. При необходимости настройте
параметры.

ПРИМЕЧАНИЕ. На странице свойств
доступны не все варианты, если
внешний монитор не подключен к
прибору.

4. Щелкните OK, чтобы применить
настройки и закрыть страницу
свойств.

ПРИМЕЧАНИЕ. Хотя это и не рекомендуется, можно подключить второй монитор после включения
анализатора. Однако после подключения вам также потребуется включить Extended Desktop в панели
управления драйвером Intel Extreme Graphics 2M.
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Проверка прибора
Запустите диагностическое приложение (Tools > Diagnostics (Сервис > Диагностика)). Если возникают какие-либо
отклонения от штатного режима, для получения дополнительных сведений о них выполните приведенные ниже
действия. Эти действия можно также выполнять с целью подробной первоначальной проверки работоспособности
прибора. Если необходимо проверить точностные характеристики прибора, обратитесь к руководству по
эксплуатации в формате PDF SPECMON3 and SPECMON6 Real-Time Spectrum Analyzers Specifications and
Performance Verification Technical Reference (Анализаторы спектра в реальном масштабе времени серии SPECMON3
и SPECMON6. Руководство по техническим характеристикам и проверке эксплуатационных параметров) (номер по
каталогу 077-0742-XX), которое содержится на компакт-диске с документацией.

1. Выберите Tools > Diagnostics
(Сервис - Диагностика).

2. На вкладке Diagnostics
(Диагностика) щелкните All
Modules, All Tests (Все модули,
все проверки).

3. Щелкните Single Test
(Одиночная проверка).

4. Нажмите кнопку RUN
(выполнить).

Прибор будет поочередно
запускать проверки. По
мере выполнения проверок
справа от каждого флажка
будет появляться значок
проверки в виде «галочки»
или буквы X. Значок проверки
(галочка) означает, что проверка
пройдена. Значок X означает,
что проверка завершилась
неудачно.

5. При выполнении проверок,
требующих вмешательства
пользователя, для выполнения
проверок следуйте инструкциям,
появляющимся на экране.

ПРИМЕЧАНИЕ. Выберите вкладку Diags Failure Info, чтобы просмотреть основную диагностическую
информацию об отказах. Для просмотра отказов в отчете приложения воспользуйтесь инструментом Windows
Event Viewer (Control Panel > System and Security > Administrative Tools > Event Viewer (панель управления > система
и безопасность > администрирование > просмотр событий)).
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Техническое обслуживание, выполняемое пользователем
Чистка прибора

Чистка внешних поверхностей корпуса выполняется сухой тканью, не оставляющей волокон, или мягкой щеткой.
Оставшееся загрязнение может быть удалено тканью или щеткой, смоченной в 75% растворе изопропилового
спирта. Узкие места вокруг элементов управления и разъемов следует прочищать щеткой. Не используйте для
чистки какой-либо части прибора абразивные вещества, поскольку они могут повредить прибор.

ОСТОРОЖНО. В ходе чистки внешних поверхностей не допускайте попадания влаги внутрь прибора;
пользуйтесь только увлажненной тканью или ватой. Не промывайте выключатель питания и ждущего режима
на передней панели. Закрывайте выключатель во время влажной чистки прибора. При чистке используйте
только деионизированную или дистиллированную воду. Используйте 75% раствор изопропилового спирта в
качестве чистящего средства, остатки раствора следует удалять деионизированной или дистиллированной
водой. Не пользуйтесь химическими чистящими веществами; они могут повредить корпус прибора. Избегайте
использования химикатов, содержащих бензол, толуол, ксилол, ацетон и другие похожие растворители.

ОСТОРОЖНО. Во избежание повреждения плоскопанельного дисплея не пользуйтесь чистящими средствами.
Не используйте для чистки поверхности экрана абразивные средства или очистители для технического стекла.
Избегайте распыления жидкостей непосредственно на поверхность дисплея. Не прикладывайте усилий при
чистке дисплея.

Выполняйте чистку поверхности экрана, осторожно протирая экран чистящей салфеткой для чистого помещения.
Если экран загрязнен сильно, увлажните чистящую салфетку дистиллированной водой или 75% раствором
изопропилового спирта, а затем слегка протрите поверхность экрана. Не прикладывайте излишних усилий; это
может повредить поверхность экрана.

Обновление программного обеспечения прибора

Обновления программного обеспечения предоставляются корпорацией Tektronix. Их можно либо загрузить с веб-узла
корпорации Tektronix, либо заказать в региональном представительстве корпорации Tektronix. Чтобы установить
дополнительные программные опции или функции, вам потребуется ключ опции, предоставляемый корпорацией
Tektronix. Получив программное обеспечение от корпорации Tektronix, установите его на приборе. После запроса
введите ключ опции, затем следуйте интерактивным инструкциям, чтобы завершить установку обновления.

Возврат прибора

При возврате прибора в корпорацию Tektronix:

Сделайте резервные копии любых программ на жестком диске. Возможно, вам потребуется переустановить
программное обеспечение после возврата прибора.

При упаковке прибора для отправки используйте оригинальную упаковочную тару. Если упаковочная тара
отсутствует или не пригодна для использования, обратитесь в региональное представительство корпорации
Tektronix, чтобы получить новую упаковочную тару.

Заклейте упаковочную картонную коробку клейкой лентой или закрепите с помощью специального степлера.
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Работа

Ознакомление с прибором
Ниже на рисунках и в таблицах показаны элементы управления и экранные элементы.

Элементы управления передней панели

Большинство элементов управления на передней панели представляют собой кнопки быстрого доступа для
открытия панелей управления.
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Номер
выноски Элемент Описание

Эквивалент
меню

1 Носитель
информации

Съемный твердотельный жесткий диск.

2 Displays
(Экраны)

Открывает диалоговое окно Displays (Экраны) для
выбора измерительных экранов.

Setup > Displays
(Настройка -
Экраны)

3 Settings
(Параметры)

Открывает панель управления Settings (Параметры) для
выбранного экрана.

Setup > Settings
(Настройка -
Параметры)

4 Trigger (Синхро-
низация)

Открывает панель управления Trigger (Синхронизация). Setup > Trigger
(Настройка -
Синхронизация)

5 Acquire (Сбор
данных)

Открывает панель управления Acquire (Сбор данных). Setup > Acquire
(Настройка - Сбор
данных)

6 Analysis
(Анализ)

Открывает панель управления Analysis (Анализ). Setup > Analysis
(Настройка -
Анализ)

7 Freq (Частота) Настройка частоты измерения. Setup > Analysis >
Frequency tab
(Настройка -
Анализ - вкладка
Частота) 2

8 Span (Spectrum)
(Интервал
(спектра))

Настройка интервала или частотного диапазона,
показанного на экране Spectrum (Спектр). 1

Setup > Settings
> Freq & Span
(Настройка -
Параметры
- Частота -
Интервал) 1 2

9 Amplitude
(Амплитуда)

Настройка опорного уровня. Setup > Amplitude
(Настройка -
Амплитуда) 2
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Номер
выноски Элемент Описание

Эквивалент
меню

10 BW (Spectrum)
(Полоса
пропускания
(спектра))

Настройка полосы разрешения (RBW). 1 Setup > Settings
> BW tab
(Настройка -
Параметры
- вкладка
BW (Полоса
пропускания) 1

2

1 Применимо в том случае, когда выбранным экраном является экран Spectrum (Спектр), DPX Spectrum (Спектр DPX) или Spectrogram
(Спектрограмма).

2 Нажмите и удерживайте в течение одной секунды, чтобы открыть соответствующую панель управления.

Номер
выноски Элемент Описание

Эквивалент
меню

12 Run (Stop)
(Пуск/стоп)

Кнопка предназначена для пуска и останова сбора
данных.

Run > Run (Пуск -
Пуск)

13 Markers, Peak
(Маркеры,
Пиковое
значение)

Перемещение активного маркера к максимальному
значению осциллограммы на выбранном экране. Если
маркеры отключены, то около максимального (пикового)
значения появится маркер MR (маркер опорного
значения).

14 Markers, Select
(Маркеры,
Выбор)

Выбор следующего маркера.

15 Markers, Define
(Маркеры,
Определение)

Открывает панель управления Markers (Маркеры).

17 Регулятор Увеличение/уменьшение значений точного разрешения.
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Номер
выноски Элемент Описание

Эквивалент
меню

18 Кнопки со
стрелками

Перемещение маркеров. Стрелка ВВЕРХ перемещает
выбранный маркер на 10 точек по осциллограмме
вправо. Стрелка ВНИЗ перемещает выбранный
маркер на 10 точек по осциллограмме влево. Стрелки
ВЛЕВО и ВПРАВО перемещают выбранный маркер
к следующему максимальному (пиковому) значению.
(Поворот регулятора перемещает маркер на одну точку
на осциллограмме влево или вправо.)

19 Клавиши
увеличения/уме-
ньшения

Увеличение или уменьшение значений грубого
разрешения.

20 Markers, Delete
(Маркеры,
Удаление)

Удаление маркера с наибольшим номером.

21 Markers, Add
(Маркеры,
Добавление)

Добавление маркера к выбранной кривой.

22 Replay
(Повторное вос-
произведение)

Отображение записи текущей регистрации.

23 Single
(Однократн.)

Установка одиночного режима запуска и запуск сбора
данных в режиме одиночного запуска.

Номер
выноски Элемент Описание

Эквивалент
меню

24 Клавиатура Ввод значений для элементов управления.

25 Enter (Ввод) Завершение ввода данных в элементах управления.
Нажатие этой кнопки аналогично нажатию кнопки Enter
на клавиатуре.
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Номер
выноски Элемент Описание

Эквивалент
меню

26 Recall (Вызов) Открывает диалоговое окно Recall (Вызов). File > Recall...
(Файл - Вызов)

27 Save
(Сохранить)

Сохранение рабочего файла, использующего те же
настройки пользователя, как в предыдущем действии
сохранения.

File > Save (Файл
- Сохранить)

28 Touch Screen Off
(Выключение
сенсорного
экрана)

Включение и выключение сенсорного экрана.
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Номер
выноски Элемент Описание

Эквивалент
меню

29 Help (Cправка) Отображение интерактивной справки. Help > User
Manual (Справка
- Руководство
пользователя)

31 Application
(Приложение)

Открывает диалоговое окно Application preset
(Предварительные установки приложения). Можно
изменить эффект нажатия опции Application
(Приложение) с помощью настроек в Setup >More
presets > Preset Options > Preset type/action (Настройка
> Дополнительные предварительные установки >
Опции предварительной установки > Тип/действие
предварительной установки).

Setup > Preset
(Настройка -
Предварительная
установка)

32 DPX Для приборов с опцией 200 открывает DPX с разверткой
по всему диапазону частот прибора. Для приборов
без опции 200 открывает экран DPX с разверткой
по максимальной полосе пропускания прибора в
реальном масштабе времени. Можно изменить эффект
нажатия опции DPX с помощью настроек в Setup > More
presets > Preset Options > Preset type/action (Настройка
> Дополнительные предварительные установки >
Опции предварительной установки > Тип/действие
предварительной установки).

Setup > More
Presets >
Application
(Настройка >
Дополнительные
предварительные
установки >
Приложение)

33 User
(Пользователь)

Открывает диалоговое окно User preset
(Пользовательские предварительные установки).
Можно изменить эффект нажатия опции User
(Пользователь) с помощью настроек в Setup > More
presets > Preset Options > Preset type/action (Настройка
> Дополнительные предварительные установки >
Опции предварительной установки > Тип/действие
предварительной установки).

Setup > More
Presets > DPX
(Настройка >
Дополнительные
предварительные
установки > DPX)

34 Предваритель-
ная установка

Восстановление заводских установок прибора по
умолчанию. Можно изменить эффект нажатия опции
Preset (Предварительная установка) с помощью
настроек в Setup > More presets > Preset Options
> Preset type/action (Настройка > Дополнительные
предварительные установки > Опции предварительной
установки > Тип/действие предварительной установки).

Setup > More
Presets > User
(Настройка >
Дополнительные
предварительные
установки >
Пользователь)
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Разъемы передней панели

Номер
выноски Элемент Описание

1 Выход сигнала
синхронизации

Выходной разъем сигнала синхронизации. 50 Ом, BNC, верхний предел > 2,0 В,
нижний предел < 0,4 В, (выходной ток 1 мА)

2 Вход сигнала
синхронизации

Входной разъем внешнего сигнала синхронизации, диапазон от –2,5 до 2,5 В,
уровень синхронизации настраивается пользователем

3 Порт USB Разъем USB 2.0

4 Порт USB Разъем USB 2.0

5 Вход
радиосигнала

Входной разъем радиосигнала, 50 Ом

Задняя панель

Номер
выноски Разъем, описание

1 Вход напряжения переменного тока, разъем сети питания

2 GPIB

4, 5 Выход IQ в реальном масштабе времени (опция 55)

6 Выход +28 В постоянного тока, переключаемый

7 Вход микрофона; выходы головного телефона и аудиосигнала; разъем линейного входа
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Номер
выноски Разъем, описание

8 2-ой вход внешнего сигнала синхронизации

9 COM 2, последовательный порт для подсоединения периферийных устройств

10 VGA, выход внешнего монитора (разрешение не ограничивается стандартом VGA)

11 Вход клавиатуры PS2

12 Порты USB 2.0 для мыши и других периферийных устройств (принтеры, внешние жесткие диски)

13 Разъем Ref Out, выход опорного сигнала частоты

14 Разъем Ref In, вход опорного сигнала частоты

15 Разъем ЛВС, разъем сети Ethernet

Интерфейс и экранные элементы

Часто используемые кнопки и элементы управления располагаются на панели инструментов. Большинство кнопок
открывают панели управления для изменения настроек прибора. Содержимое панелей управления изменяется в
зависимости от выбранного экрана. Кроме того, получить доступ к панелям управления можно с помощью кнопок,
расположенных на передней панели, или с помощью клавиатуры.
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Номер
выноски Элемент Описание

1 Displays (Экраны) Открывает диалоговое окно Select Displays (Выбор экранов), в котором
можно выбрать измерительные экраны

2 Markers (Маркеры) Открывает или закрывает панель инструментов Marker (Маркер) в нижней
части окна

3 Settings (Настройки) Открывает панель управления настройками выбранного экрана. На
каждом экране имеется своя собственная панель управления.

4 Trigger
(Синхронизация)

Открывает панель управления синхронизацией, позволяющей задавать
параметры синхронизации

5 Acquire (Сбор
данных)

Открывает панель управления сбором данных, в которой можно задать
параметры сбора данных

6 Analysis (Анализ) Открывает панель управления анализом, в которой можно задать
параметры анализа, такие как частота, время анализа и единицы
измерения

7 Измеряемая частота Отображение измеряемой частоты. Чтобы изменить значение, щелкните
текст и введите частоту регулятором, расположенным на передней панели
прибора. Можно также ввести значение частоты с помощью клавиатуры
на передней панели или воспользоваться там же расположенными
кнопками ВВЕРХ и ВНИЗ.

8 Уровень опорного
сигнала

Отображение уровня опорного сигнала. Чтобы изменить значение,
щелкните текст и введите число с помощью клавиатуры или
воспользуйтесь кнопками ВВЕРХ и ВНИЗ на передней панели.

9 Amplitude
(Амплитуда)

Открывает панель управления амплитудами, в которой можно задать
уровень опорного сигнала, настроить внутреннее ослабление и включить
или отключить (дополнительно поставляемый) предусилитель.

10 Replay
(Воспроизведение)

Запуск нового цикла измерений в существующей записи собранных
данных, используя новые настройки.

11 Run (Пуск) Запуск и остановка сбора данных. В период сбора данных название
кнопки выводится буквами зеленого цвета. После прекращения сбора
данных название кнопки выводится буквами черного цвета.

Условия запуска можно определить в меню Run (Пуск). Например, если в
меню Run (Пуск) выбрать пункт Single Sequence (Одиночный запуск), то
после нажатия кнопки Run (Пуск) на приборе будет запущен только один
цикл измерений. Если выбрать пункт меню Continuous (Непрерывный),
то прибор будет выполнять непрерывный сбор данных, пока он не будет
остановлен пользователем.

12 Значок в виде
галочки Индикатор в виде галочки ( ) в верхнем левом углу экрана используется

для обозначения экрана, для которого оптимизирована аппаратура для
регистрации данных. В случае выбора опции Best for multiple windows
(Лучшее для нескольких окон) на элементе управления оптимизации RF
и IF панели управления амплитудами, ни на одном из измерительных
экранов не будет отображаться галочка, поскольку отсутствует единое
измерение повышенной точности.

13 Отображает диалоговое окно Open (Открыть), позволяющее загрузить
файл настроек или файл данных регистрации.
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Номер
выноски Элемент Описание

14 Открывает диалоговое окно Save As (Сохранить как), позволяющее
сохранить настройки, изображение экрана, файл данных регистрации или
экспортировать результаты или настройки.

15 Отображает диалоговое окно Main Presets (Основные предварительные
установки) или вызывает окно Preset (Main) (Предварительные установки
(Основные)), в зависимости от текущих настроек.

Элементы управления, имеющие отношение к дисплею

У большинства дисплеев часто используемые элементы управления расположены вокруг графического окна.
Они обеспечивают быстрый доступ к общим настройкам; полный комплект элементов управления для дисплея
находится на панели управления Settings (Параметры). Ниже на рисунке и в таблице приведены некоторые из часто
используемых значков, которые появляются на большинстве дисплеев.
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Таблица 1: Часто используемые значки

Номер
выноски

Значок
элемента
управления Описание

1 Раскрывающийся список. Щелкните его, чтобы выбрать значение из
раскрывающегося списка.

2 Регулятор. Щелкните, чтобы выбрать элемент управления, когда курсор
находится на значке или на текстовой надписи. Затем можно изменить
значение с помощью регулятора, расположенного на передней панели, с
помощью кнопок со стрелками или ввести значение на клавиатуре.

3 6.337μs (6,337
мкс)

Цифры, выделенные курсивным шрифтом. Эти цифры показывают
автоматически выбранные значения элементов управления. Несколько
элементов управления в приборе (например, RBW (Полоса разрешения) и
Analysis Length (Длина анализа)) позволяют выбрать автоматический режим
Auto (Авто). В автоматическом режиме программное обеспечение прибора
автоматически устанавливает значение. Изменив это значение, можно
изменить режим элемента управления на ручной режим. Чтобы вернуться в
автоматический режим, удалите значение, затем нажмите кнопку Enter.

24 SPECMON3 и SPECMON6 — краткое руководство по эксплуатации



Работа

Основные сведения
Анализаторы в реальном масштабе времени

Анализаторы в реальном масштабе времени Tektronix имеют функции синхронизации по частотной маске.
Синхронизация по частотной маске позволяет настраивать маску спектра для регистрации сигнала при
возникновении аномалии спектра. Это позволяет анализатору спектра в реальном масштабе времени проверять
100 % входных сигналов перед их регистрацией, затем выполнить точную запись нерегулярно возникающих
РЧ-событий в интересующей области.

Технология DPX™ позволяет просматривать РЧ-сигнал в реальном масштабе времени. Можно просматривать очень
короткие нестационарные сигналы, многоуровневые сигналы и изменяющиеся во времени события. Опция 200
позволяет производить измерения и синхронизацию по значениям плотности сигнала на экране DPX.

Анализаторы спектра позволяют просматривать зарегистрированные сигналы на большом количестве экранов,
синхронизированных по времени. Эта функция особенно полезна при поиске и устранении неисправностей
устройства и при определении характеристик сигналов. Все измерения, за исключением измерений с экраном,
работающим в режиме DPX, выполняются на одном и том же наборе выборок данных во временной области.

Измерительные экраны

В окне анализатора могут отображаться одна или несколько комбинаций экранов общего назначения и экранов,
относящихся к конкретным применениям.

На данном примере показан экран DPX
Spectrum Split (разделенный спектр
DPX). Экран DPXogram появляется в
верхней части, а отображение спектра
DPX — в нижней.
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В этом примере показано окно с двумя
экранами: экран отображения спектра и
экран со спектром DPX.

Когда открыто несколько экранов,
на экране со значком «галочки» над
оборудованием для получения данных
имеется элемент управления. Чтобы
обеспечить приоритет какого-либо
экрана над другими, щелкните его строку
заголовка.

В этом примере показано окно с
четырьмя экранами.

Источником зарегистрированных данных могут быть активные кривые или сохраненные в файле данные
регистрации. Благодаря возможности одновременного отображения зарегистрированных данных на разных экранах
можно просматривать одни и те же данные несколькими способами. Например, можно одновременно вывести на
экран график зависимости мощности от частоты (спектр) и спектрограмму. Поскольку на разных экранах источник
данных используется совместно, представления экранов коррелированы между собой. Т. е. точка или набор точек
на одном экране связаны с точкой или набором точек на каждом другом экране в окне приложения.
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Перемещение по экранам
Чтобы анализатор поддерживал простоту выполнения операций, но в то же время мог при необходимости
предоставить расширенные функциональные возможности, в нем используются несколько экранов. Ниже приведены
некоторые примеры категорий экранов.

Экраны общего просмотра сигналов. На этих экранах отображаются графики зависимости основных
параметров сигнала, например амплитуды, фазы и частоты, от частоты или времени. Примерами этих экранов
являются: спектр, спектр DPX, спектрограмма, временной обзор и график зависимости фазы от времени.

Аналоговая модуляция. На этих экранах отображаются графики и измерения для аналоговой модуляции,
частотной модуляции и фазовой модуляции.

Универсальные экраны цифровой модуляции. Доступны с помощью опции 21, обеспечивающей
универсальный анализ модуляции. На этих экранах отображаются результаты демодулирования сигналов и их
анализ в нескольких областях. Примерами этих экранов являются: диаграмма «созвездие», график зависимости
оценки модуля ошибки (EVM) от времени, глазковая диаграмма, таблица символов и решетчатая диаграмма.

Экраны РЧ-измерений. На этих экранах отображаются результаты автоматических измерений РЧ-сигналов.
Примерами этих экранов являются: результаты измерения мощности в канале/напряженности поля, подавление
соседнего канала (ACPR), MCPR, фазового шума и комплементарной интегральной функции распределения
(CCDF).

Анализ методом OFDM (ортогональное частотное мультиплексирование). Эти экраны обеспечивают анализ
для сигналов WLAN 802.11a/j/g и WiMax 802.16-2004 методом OFDM.

Экраны импульсных РЧ-сигналов. Доступны с помощью опции 20, обеспечивающей расширенный анализ
сигнала. На этих экранах отображаются результаты расширенного анализа импульсных РЧ-сигналов.
Примерами этих экранов являются: статистика импульса, таблица импульсов и кривая импульса.

Анализ звуковых сигналов. На этих экранах производятся измерения основных временных и частотных
параметров аналоговых звуковых сигналов, модулированных на несущих (амплитудная, частотная и фазовая
модуляция), или немодулированных (не на несущих) звуковых сигналов (прямых).

Выбор экранов
В анализаторе имеется простой способ выбора экранов.

1. Щелкните значок Displays
(экраны), чтобы открыть
диалоговое окно Select Displays
(выбор экранов).

Существует два способа выбора экранов: выбор любой комбинации экранов или использование предварительной
установки приложения.

Выбор комбинации экранов. Выбирайте экраны последовательно по мере необходимости.
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1. Щелкните папку нужного
приложения в диалоговом
окне Select Displays (выбрать
экраны).

Доступные экраны для каждой
папки приведены в области
Available Displays (доступные
экраны).

2. Щелкните один из значков
экранов.

3. Щелкните Add (добавить) (или
дважды щелкните значок),
чтобы добавить выбранный
экран в список Selected displays
(выбранные экраны). Для
добавления других экранов
повторите эту процедуру.

4. Нажмите кнопку OK, чтобы
закрыть диалоговое окно.
Откроются выбранные экраны.

Использование предварительной установки приложения. Выберите экраны из предварительных
установок своего приложения.
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1. Щелкните кнопку Application
Presets... (Предварительные
установки приложения) в диалоговом
окне Select Displays (Выбрать экраны).

2. Выберите одну из предварительных
установок:

ПРИМЕЧАНИЕ. Некоторые
предварительные установки
появляются только в случае установки
соответствующей опции прибора.

3. Нажмите кнопку OK, чтобы закрыть
диалоговое окно. Откроются экраны
предварительных установок. (См.
таблицу 2.)

Таблица 2: Предварительные установки приложения

Предварительные установки Экраны

Modulation Analysis (анализ модуляции) (только
опция 21)

Constellation («созвездие»), DPX Spectrum (спектр DPX),
Signal Quality (качество сигнала), Symbol Table (таблица
символов)

Pulse Analysis (импульсный анализ) (только
опция 20)

DPX Spectrum (спектр DPX), Pulse Table (таблица
импульсов), Pulse Trace (форма импульса), Time Overview
(временной обзор)

Анализ спектра Спектр

Многозонный поиск паразитного сигнала 9 кГц –
1 ГГц

Паразитный сигнал

Time-Frequency Analysis (частотно-временной
анализ)

Frequency vs Time (временная зависимость частоты),
Spectrogram (спектрограмма), Spectrum (спектр), Time
Overview (временной обзор)

SPECMON3 и SPECMON6 — краткое руководство по эксплуатации 29



Работа

Советы

Чтобы открыть диалоговое окно Select Displays (Выбор экранов), нажмите на передней панели кнопку Displays
(Экраны).

Чтобы добавить экран, дважды щелкните значок.

Чтобы удалить экраны, выполните одно из следующих действий:

Выберите значок экрана в списке Selected Displays (Выбранные экраны), затем щелкните кнопку Remove
(Удалить).

Дважды щелкните значок экрана в списке Selected Displays (Выбранные экраны).

Щелкните кнопку Close (Закрыть) в правом верхнем углу выбранного экрана.

Можно отображать экраны из нескольких папок приложений.

Общие информационные сообщения

Ниже в таблице приведены некоторые из общих информационных сообщений, которые могут появиться во время
обычной операции.
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Таблица 3: Общие информационные сообщения

Сообщение Объяснение и рекомендуемые действия

Acq BW too small for current
setup (Полоса пропускания
зарегистрированных данных
слишком мала для текущей
настройки)

Для этого экрана необходима более широкая полоса пропускания для
зарегистрированных данных, чем та, которая содержится в текущих данных.
Это может произойти вследствие любой из следующих причин:

Экран отличен от того экрана, который вы предполагали выбрать.
Выбранный экран запросил меньшую полосу пропускания для
зарегистрированных данных, чтобы получить лучшую точность или
лучший динамический диапазон для своих конкретных измерений.

Выберите экран с этим сообщением. Щелкните кнопку Run (Пуск),
если прибор еще не регистрировал данные.

Регистрации не запускаются, а измерение запрашивает более широкую
полосу пропускания, чем во время прошлой регистрации.

Щелкните кнопку Run (Пуск), чтобы выполнить новую регистрацию с
более широкой полосой пропускания.

Данные получаются из восстановленного файла.

Отсутствует способ увеличения полосы пропускания регистрации
для сохраненных данных. Следует настроить параметры измерений
таким образом, чтобы запрашивалась меньшая полоса пропускания.

Need swept acq or larger Acq
BW (Требуется развернутая
регистрация или более широкая
полоса пропускания регистрации)

Когда какой-либо экран запрашивает развернутую регистрацию, другие
экраны не могут обрабатывать развернутые данные. Это происходит
вследствие того, что развернутые данные настраиваются для выбранного
экрана.

Выберите экран, представляющий интерес, и параметры регистрации
автоматически изменятся, чтобы соответствовать требованиям
выбранного экрана.

RBW increased to 100 kHz (Полоса
разрешения (RBW) увеличена до
100 кГц)

Текущая длина спектра или длина анализа недостаточно большие, чтобы
позволить более узкий фильтр полосы разрешения.

Если значением элемента управления Length (Длина) является Manual
(Вручную), попытайтесь увеличить его или установить для него значение
Auto (Авто) с тем, чтобы значение параметра Analysis Length (Длина
анализа) увеличилось до необходимого значения.

Изменение параметров измерения

На экранах имеются настройки, которые управляют способом получения и обработки данных. Настройки, которые
можно изменять, зависят от выбранного экрана.

Для получения доступа к настройкам (в нашем случае, для экрана Spectrum (Спектр)):
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1. Щелкните кнопку Settings
(Параметры), чтобы открыть панель
управления Settings (Параметры).

2. Настройте элементы управления,
как это требуется для сигнала
или проверки. Например,
используйте вкладку Freq & Span
(частота и диапазон) для установки
частоты и диапазона. Большинство
панелей управления имеет вкладки,
которые обеспечивают легкий доступ
к другим взаимосвязанным элементам
управления.

3. Используя вкладку Prefs
(предпочтения), можно изменять
внешний вид экрана дисплея.
Следующие элементы управления
применимы не для всех экранов.
Некоторые экраны имеют
дополнительные элементы
управления, которые не описаны в
данном руководстве по эксплуатации.

Чтобы включить или выключить
масштабную сетку, используйте
флажок Show graticule
(отобразить масштабную сетку).

Чтобы включить или выключить
показания маркера, используйте
флажок Show Marker readout in
graph (отобразить на графике
показания маркера).

Чтобы включить или выключить
пояснения к кривой, используйте
флажок Show trace legend
(отобразить пояснения к кривой).

Совет

Если на экране отображается несколько представлений, щелкните в любом месте одного из представлений,
чтобы изменить панель управления для этого представления.

Предварительная настройка прибора

На приборе можно выполнить предварительные настройки, чтобы восстановить установки до своих значений по
умолчанию.
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1. Чтобы начать работать с настройками
прибора по умолчанию, нажмите
на передней панели кнопку Preset
(Предварительная установка) или
выберите Preset (Предварительная
установка) в меню Setup (Настройка).

Совет

Предварительная установка не изменяет параметры, определенные в панели управления Config In/Out
(Конфигурация входящего или выходящего сигнала), или в меню Tools (Сервис), например, адрес GPIB,
настройки Save/Export (Сохранить/Экспорт) или параметр Auto Alignment (Автоматическое согласование).

Подача сигнала
На анализаторе имеется единый вход радиочастотного (РЧ) сигнала, расположенный на передней панели. Перед
подачей сигнала на вход прибора ознакомьтесь с требованиями к входному сигналу.

ОСТОРОЖНО. Во избежание повреждения прибора или его принадлежностей статическим электричеством
перед подключением кабелей ко входам прибора снимите на шину заземления электростатический заряд,
который может быть на центральном и наружном проводниках разъема. Не создавайте антенну ПЭР
(повреждение электростатическим разрядом), оставляя неподсоединенными другие концы кабелей, которые
уже подсоединены к прибору.

Необходимые уровни сигнала

Ниже в таблице приведены минимальные уровни входного сигнала для выполнения измерений. Точность
обеспечивается амплитудой и частотой сигнала (точка нормализации). Измерения сигналов можно выполнять
внутри всего диапазона допустимых входных сигналов с погрешностью, зависящей от частоты и амплитуды
измеряемого сигнала (дополнительные сведения см. в информационном листке с техническими данными для
анализаторов спектра SPECMON3 и SPECMON6).

SPECMON3 и SPECMON6 — краткое руководство по эксплуатации 33



Работа

Диапазон входных РЧ-сигналов (для незатухающей гармонической волны или для максимального
значения мощности огибающей)

Требование к измерению параметров
модуляции Требование к спектру сигнала

От –50 до +30 дБм От среднего уровня шумов (DANL) до +30 дБм

Требования к входным сигналам

Характеристика Описание

Входное сопротивление 50 Ом

Диапазон частот входного сигнала

SPECMON3

SPECMON6

SPECMON3/SPECMON6

От 9 кГц до 3 ГГц (РЧ-диапазон)

От 9 кГц до 6,2 ГГц (РЧ-диапазон)

От 1 Гц до 32 МГц (НЧ-диапазон)

Максимальная измеряемая мощность
непрерывного входного сигнала

1 Вт (+30 дБм)

Максимальное номинальное напряжение ±5 В постоянного тока, связанное по переменному току

ОСТОРОЖНО. Во избежание повреждения прибора не подавайте на вход сигналы с незатухающей гармонической
волной мощностью более 1 Вт (+30 дБм). Максимальное номинальное напряжение ±5 В постоянного тока.
Максимальные параметры импульса: пиковая мощность 50 Вт, длительность импульса менее 10 мкс,
скважность 0,001, ослабление не менее 30 дБ.

Для подачи РЧ-сигнала:

Подайте сигнал на разъем RF INPUT
(вход РЧ-сигнала), расположенный на
передней панели.
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Совет

Если сигнал источника более 1 Вт (+30 дБм), подайте сигнал источника на аттенюатор. Подсоедините выход
аттенюатора к входному разъему РЧ-сигнала.

Запуск и прекращение регистрации данных

1. Щелкните кнопку Run (прогон),
чтобы начать регистрацию
данных.

Чтобы выбрать режим Run
(прогон), щелкните значок
выпадающего списка справа от
кнопки Run (прогон).

Выберите Single (однократный)
или Continuous (непрерывный)
для установки требуемого
режима Run (прогон).

Если анализатор находится
в режиме Continuous Run
(непрерывный прогон),
кнопка Replay (повторное
воспроизведение) будет тускло
светиться все время, пока будет
осуществляться регистрация
данных. Если регистрация не
производится, кнопка Replay
(повторное воспроизведение)
горит синим цветом.

2. Для прекращения регистрации
данных щелкните кнопку Stop
(стоп). Если выполняется
анализ, то завершение
регистрации произойдет
по завершении анализа
последовательности сигналов.
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Совет

Чтобы начать или прекратить регистрацию данных, нажмите на передней панели кнопку Run (Пуск).

Элемент управления Run (Пуск)

Меню Run (Пуск) обеспечивает доступ к командам, которые управляют регистрацией данных и последовательностью
измерений. Для получения информации обо всех вариантах выбора в меню Run (Пуск) см. интерактивную справку.
Вариантом выбора по умолчанию является пункт Continuous (Непрерывный). При выборе пункта меню Continuous
(Непрерывный) прибор будет непрерывно получать данные, пока пользователь не остановит процесс регистрации
данных. Выберите пункт меню Single Sequence (Одиночный запуск), чтобы запускать единичную регистрацию данных
при каждом выборе меню Run (Пуск) или при каждом нажатии кнопки Run (Пуск) на передней панели прибора.

Маркеры
Для измерения времени, частоты, мощности и других параметров используйте маркеры. Маркеры измеряют
абсолютные значения, и можно также измерить разницу между маркерами.

Использование маркеров для измерения частоты и мощности

Процедура ниже показывает, как использовать маркеры на экране Spectrum (Спектр) для измерения частоты и
мощности. В примере предполагается, что все маркеры отключены, и что сигнал отображается на экране.
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1. Щелкните Markers (Маркеры),
чтобы открыть панель
инструментов Markers
(Маркеры), расположенную в
нижней части окна анализа.

2. В раскрывающемся меню
панели инструментов Markers
(Маркеры) выберите пункт Add
Marker (Добавить маркер).

Первый маркер называется
маркером опорного сигнала
(MR).

3. Измените положение маркера
на экране, используя кнопки
со стрелками в панели
инструментов Markers
(Маркеры). Также можно
перетащить маркер в нужное
положение с помощью
сенсорного экрана или мыши.

4. Считайте с экрана в поле
значений маркера значение
частоты и уровень мощности.

Отображение маркеров

Прямоугольные маркеры показывают абсолютные значения в поле значений маркера. Поле значений
выбранного маркера появляется в левом верхнем углу экрана и в панели инструментов Markers (Маркеры).

Маркеры в виде ромба показывают разность значений (по отношению к маркеру опорного сигнала). Поле
значений выбранного маркера появляется в правом верхнем углу экрана и в панели инструментов Markers
(Маркеры).

При перетаскивании маркеров вдоль осциллограммы с помощью либо сенсорного экрана, либо мыши, маркер
будет искать верхние точки. Маркер остается в пределах 20 точек осциллограммы от положения мыши. Если в
пределах текущего диапазона точек осциллограммы отсутствуют пиковые значения, то маркер находит самую
высокую точку.
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Если привязать маркер к кривой растрового отображения спектра DPX, наряду с частотой и мощностью на экран
будет выводиться показание маркера в виде отсчета для конкретного пикселя (максимум 65 536) (см. следующий
рисунок). Маркер можно устанавливать в любой точке графика.

Если установлена опция 200, показания маркеров, привязанных к пикселям растрового отображения спектра
DPX, представляют собой плотность сигнала в процентах, а не в виде отсчетов.

Советы

Если маркеры отключены, щелкните Peak (Пиковое значение) в панели инструментов или на передней панели,
чтобы добавить маркер опорного сигнала (MR) и поместить его на максимальном уровне осциллограммы
выбранного экрана.

Чтобы открыть табличное представление сведений о маркере, щелкните кнопку Table (Таблица) в панели
инструментов Markers (Маркеры).

Панель инструментов Markers (Маркеры)

На панели инструментов Markers (Маркеры) имеется несколько элементов управления для работы с маркерами.
(См. таблицу 4.) Некоторые из этих элементов управления напоминают элементы управления на передней панели
прибора.
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Таблица 4: Панель инструментов Markers (Маркеры)

Значок Описание

Открывает панель управления Define Markers (Задание маркеров). Используйте эту панель
управления для добавления и удаления маркеров для настройки параметров маркеров.

Настройка частоты измерений прибора в качестве частоты для выбранного маркера.
Эта кнопка присутствует только тогда, когда в выбранном экране частота находится на
горизонтальной оси.

Перемещение маркера к максимальному (пиковому) значению на осциллограмме.
Максимальное пиковое значение может быть как самой высокой, так и самой низкой точкой
на экранах с положительным и отрицательным значением на вертикальной оси (например,
погрешность частоты или фаза).

Перемещение выбранного маркера к следующему пиковому значению влево от текущего
положения.

Перемещение выбранного маркера к следующему пиковому значению вправо от текущего
положения.

Перемещение выбранного маркера к следующему нижнему пиковому значению. Под
пиковым значением понимается абсолютное значение пиковой амплитуды. При повторном
перемещении маркера он может перемещаться в любом направлении независимо от
положения следующего пика. Если маркер привязан к кривой точечных изображений DPX,
эта кнопка перемещает его на ближайший по величине более низкий пик плотности при
той же самой частоте.

Перемещение выбранного маркера к следующему верхнему пиковому значению. Под
пиковым значением понимается абсолютное значение пиковой амплитуды. При повторном
перемещении маркера он может перемещаться в любом направлении независимо от
положения следующего пика. Если маркер привязан к кривой точечных изображений DPX,
эта кнопка перемещает его на ближайший по величине более высокий пик плотности при
той же самой частоте.

Открывает или закрывает таблицу маркеров на экране.

Добавление маркеров

Можно создать до пяти маркеров. Первый маркер (MR) – это маркер опорного сигнала. Другие маркеры (M1,
M2, M3 и M4) могут показывать абсолютные значения или показывать как абсолютные значения, так и разность
значений данного маркера и маркера опорного сигнала.

Чтобы добавить другой маркер, в раскрывающемся списке на панели инструментов выберите пункт Add Marker
(Добавить маркер).

Задание маркеров

Для задания параметров маркеров используйте панель управления Define Markers (Задание маркеров).
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1. Чтобы открыть панель управления
Define Markers (Задание маркеров),
щелкните кнопку Define (Задать).

Используйте панель управления, чтобы:

Добавить или удалить маркеры.

Отключить маркеры.

Назначить маркеры определенным
осциллограммам.

Установить для поля значений
маркера вариант отображения
абсолютных значений или разности
значений.

Задать пороговые значения и
значения отклонений.
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Совет

Можно добавить или удалить маркеры из раскрывающегося списка рядом с кнопкой Define (Задать) в панели
инструментов маркеров.

Использование сенсорного экрана
Сенсорный экран можно использовать для изменения параметров настройки маркеров и отображения кривых с
помощью меню Touchscreen Actions (Действия с сенсорным экраном). Чтобы использовать меню Touchscreen
Actions (Действия с сенсорным экраном), коснитесь экрана, задержав палец на одну секунду. Кроме того, можно
открыть меню Touchscreen Action (Действия с сенсорным экраном) с помощью мыши, для чего достаточно нажать
правую кнопку мыши.

Обратите внимание, что некоторые
пункты меню Touchscreen Actions
(Действия с сенсорным экраном)
доступны только в том случае, если задан
маркер.

Меню Touchscreen Actions (Действия с сенсорным экраном)

Таблица 5: Меню Touchscreen Actions (Действия с сенсорным экраном)

Значок Пункт меню Описание

Select (Выбрать) Используется для выбора маркеров и настройки их положений.

Span Zoom
(Увеличение
интервала)

Увеличение области графика вокруг выбранной точки. Коснитесь графика
в интересующей точке и с помощью перетаскивания увеличьте или
уменьшите интервал вблизи этой точки. Функция Span Zoom (Увеличение
интервала) используется для настройки интервала и может влиять на
полосу пропускания для зарегистрированных данных.

CF Pan
(Согласование
центральной
частоты)

Используется для настройки центральной частоты в соответствии с
перемещением по горизонтали.
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Таблица 5: Меню Touchscreen Actions (Действия с сенсорным экраном) (прод.)

Значок Пункт меню Описание

Zoom (Масштаб) Используется для настройки масштаба графика по горизонтали и по
вертикали. Основной шкалой настройки становится первое направление
с достаточным перемещением. Настройка по второму направлению не
выполняется, пока не будет достигнуто пороговое значение перемещения в
30 пикселов.

При перетаскивании влево и вниз происходит уменьшение отображаемой
кривой (масштаб увеличивается). При перетаскивании вправо и вверх
происходит увеличение отображаемой кривой (масштаб уменьшается).

Pan (Панорама) Используется для настройки положения кривой по горизонтали и по
вертикали. Основным направлением перемещения становится первое
направление с достаточным перемещением. Перемещение по второму
направлению не выполняется, пока не будет достигнуто пороговое значение
перемещения в 30 пикселов.

— Reset scale
(Сброс
параметров
шкалы)

Возврат параметров шкалы и положения по горизонтали и по вертикали к
значениям, заданным по умолчанию.

— Marker to peak
(Маркер на пик)

Перемещение выбранного маркера на самый высокий пик. При отсутствии
маркеров происходит автоматическое добавление маркера.

— Next Peak
(Следующий пик)

Перемещение выбранного маркера на следующий пик. Возможные
варианты: Next left (Следующий слева), Next right (Следующий справа), Next
lower (Следующий более низкий, по абсолютному значению) и Next higher
(Следующий более высокий, по абсолютному значению).

— Add marker
(Добавить
маркер)

Определение нового маркера, расположенного в центре графика по
горизонтали.

— Delete marker
(Удалить маркер)

Удаление последнего добавленного маркера.

— All markers off
(Отключить
маркеры)

Удаление всех маркеров.

Функция
Trigger On This
(синхронизация
по ...)

Располагает измерительное окно плотности DPX в месте, где был
произведен щелчок мыши, измеряет плотность текущего сигнала, на основе
результата измерения устанавливает функцию синхронизации по плотности
DPX и запускает регистрацию.
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Печать
Можно распечатать копию экрана и его содержимое (мгновенный снимок) на принтере или в файл.

1. Нажмите кнопку Print (Печать) на
передней панели или выберите пункт
Print (Печать) в меню File (Файл).
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2. Выполните необходимые изменения
в диалоговом окне «Печать», затем
щелкните OK.

Диалоговое окно «Печать» – это
стандартное диалоговое окно
«Печать» Microsoft Windows.
Элементы управления печатью
зависят от вашего принтера.

Режим экономии чернил

Можно осуществлять печать образов экрана на белом фоне.

1. Выберите пункт Options (параметры)
в меню Tools (сервис).

2. В панели управления выберите
вкладку Colors (цвета).

3. Задайте параметру Color Scheme
(цветовая схема) значение Blizzard
(пурга).

На графиках цвет фона меняется от
черного до белого.
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Сохранение данных
Можно сохранять другие типы данных для будущего применения.

1. Выберите Save As. (Сохранить как)
в меню File (Файл), чтобы открыть
диалоговое окно Save As (Сохранить
как).

2. Перейдите в папку, в которой
предполагается сохранить настройки,
или используйте местоположение по
умолчанию.

3. Введите имя файла.

4. Выберите тип файла для сохранения.
(См. таблицу 6.)

5. Нажмите кнопку Save (Сохранить).

Таблица 6: Типы файлов для сохранения

Типы файлов Описание

Файлы настройки Сохранение всей информации о настройке для всех экранов с параметрами, за
исключением тех параметров, которые задаются в меню Tools (Сервис) (Alignments
(Выравнивания) и Options (Параметры)) или на панели управления Config In/Out
(Конфигурация входящего или выходящего сигнала).

Результаты файлов
экспорта

Сохранение осциллограммы и числовых данных для выбранного экрана.
Осциллограмма и числовые данные сохраняются в формате CSV как текстовые
файлы.

Рисунок (PNG/JPG/BMP) Сохранение графического представления экрана в выбранном формате. Этот
вариант удобен для включения графических материалов в отчеты или другие
приложения. Также включаются показания маркеров и другая информация.

Выбранная осциллограмма Сохранение осциллограммы для последующего отображения ее на экране, с
которого она была сохранена.

Данные (данные
регистрации и экспорт
данных регистрации)

Сохранение данных для повторного анализа на анализаторах серии SPECMON3
и SPECMON6 или в форматах CSV (значения, разделенные запятыми) или MAT
(Matlab) для использования с внешним программным обеспечением.
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Советы

Выберите File > Save (Файл - Сохранить) или нажмите кнопку Save (Сохранить), чтобы сохранить сведения в
файле, используя то же самое имя, путь и тип данных, как при предыдущем сохранении. Когда файл уже
существует, нижний индекс имени файла будет пронумерован, если предварительно выбран этот вариант на
вкладке панели управления Tools > Options > Auto Filename (Сервис - Параметры - Автонумерация файлов).

Выберите File > Save As (Файл - Сохранить как), чтобы открыть стандартное диалоговое окно Windows
«Сохранение документа», в котором можно изменить имя файла, выбрать тип данных для сохранения и выбрать
папку для хранения файла.

Восстановление данных
Зарегистрированные данные и файлы настроек можно использовать для повторного анализа.

1. Нажмите кнопку Recall (Восстановить)
на передней панели или выберите
в меню File (Файл) пункт Recall
(Восстановить).
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2. Найдите местоположение файла
в диалоговом окне «Открытие
документа».

3. Еслифайл не удается найти, выберите
тип файла в раскрывающемся списке.

4. Чтобы загрузить файл, дважды
щелкните имя файла.

Совет

Если диапазон по оси X на восстанавливаемой осциллограмме не совпадает с диапазоном по оси Х текущего
графика, то осциллограмму не будет видно. Небольшая стрелка будет указывать за пределы экрана в направлении
восстановленной осциллограммы. Чтобы развернуть осциллограмму на экране Spectrum (Спектр), используйте
элементы управления Frequency (Частота) и Span (Интервал) (или Span (Интервал) и Offset (Смещение)). На
других экранах используйте Horizontal Scale (Масштаб по горизонтали) и Offset (Смещение) (которые также можно
использовать на экране Spectrum (Спектр)). Эти элементы управления находятся на вкладке Settings > Scale
(Параметры - Шкала).
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Нанесение результатов измерений на карту
В анализаторе имеется приложение RSA Map, позволяющее регистрировать результаты измерений и наносить
их на карту.

Файлы карт

Программа RSA Map использует карты в формате MIF или растровые файлы Windows (bmp) для обозначения
местоположения. Файлы карт в формате bmp можно либо привязывать к местности (с помощью файла в
формате карты мира для определения географического положения), либо оставить без привязки (информация о
географическом положении отсутствует).

Запуск RSA Map

Для запуска приложения RSA Map выполните приведенные ниже действия.

1. В строке меню приложения SPECMON
выберите Tools > RSA Map
(Инструменты — RSA Map).
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Программа RSA Map запустится в
отдельном окне.

Загрузка карты

Перед использованием приложения RSA Map для записи измерений необходимо загрузить карту. Если карта
была загружена во время предыдущего сеанса, она останется загруженной до тех пор, пока не будет замещена
новой картой.

1. Выберите File > Load Map (Файл —
Загрузить карту).

2. Укажите путь к файлу карты и
выберите файл для загрузки (может
потребоваться указать тип файла
карты).
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3. Нажмите кнопку Open (Открыть).
Программа RSA Map загрузит
выбранный файл карты.

Настройка приемника GPS

Для отображения GPS-координат вместе с результатами измерений при нанесении на карту в приложении RSA Map
необходимо активировать функцию GPS.

ПРИМЕЧАНИЕ. Рекомендуется использовать внешний GPS-приемник с USB-интерфейсом. GPS-приемник
должен обеспечивать вывод последовательных данных по протоколу NMEA 0183. Перед запуском приложения
RSA Map установите необходимое программное обеспечение GPS-приемника.

1. Подключите GPS-приемник к одному
из USB-портов прибора.

2. Щелкните на значке GPS.

Появится окно Setup GPS (Настройка
GPS).

3. Установите флажок Enable
(Включить).

4. Откройте раскрывающийся список
COM port (COM-порт). Выберите порт
подключения GPS-приемника.

5. Установите скорость передачи
данных, соответствующую
подключенному GPS-приемнику.

6. Нажмите Apply (Применить), чтобы
активировать GPS.
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Если GPS-приемник обменивается
данными с анализатором, в поле статуса
отображается текущая информация о
местоположении.
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7. Нажмите OK, чтобы применить
настройки GPS и закрыть окно
настройки GPS.

Если анализатор привязан к сигналу GPS,
на значке GPS отображается зеленый
символ замка.

Привязка измерения к месту на карте

Для привязки измерений к месту на карте используйте описанную ниже процедуру. Перед использованием этой
процедуры выполните приведенные ниже действия.

Загрузите карту (См. стр. 49, Загрузка карты.).

Выберите Tools > SPECMON (Инструменты — SPECMON) для перехода в приложение SPECMON и настройки
измерений, которые необходимо привязать к карте в приложении анализатора. Если необходимо привязать
к карте интенсивность сигнала, выполните необходимые для измеряемого сигнала настройки в окне Chan
Power/STR and ACPR (Мощность канала / напряженность поля и ACPR).

1. В приложении RSA Map выберите
одну из кнопок измерения. Выбранное
измерение будет выделено синим
цветом, а его название появится под
областью пиктограмм.

2. Нажмите кнопку «Единичное
измерение».
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3. Щелкните или прикоснитесь к карте.

Если приемник GPS активен и
используется карта с привязкой к
местности, единичное измерение
привязывается к текущим
координатам GPS.

Если приемник GPS не активен или
если используется графическая карта,
единичное измерение привязывается
к месту, обозначаемому на карте
прикосновением.

4. Можно также выбрать кнопку,
отвечающую за проведение другого
измерения, после чего, коснувшись
карты, добавить на нее новое
измерение. Значки нескольких
измерений, проведенных в одном и
том же месте, располагаются стопкой
один над другим.

5. Для перемещения результатов
измерения (например, если
накладываются несколько
результатов) нажмите кнопку
«Переместить результаты».

6. Прикоснитесь и переместите
результаты в новое положение. Если
значок перемещается в новую стопку
значков измерений, порядок его
размещения определяется временем
проведения измерения.
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ПРИМЕЧАНИЕ. На карте можно разместить не более 200 измерений. При достижении этого предела RSA Map
выдает сообщение и следующие измерения не принимаются. Выберите File > Save As (Файл — Сохранить как)
для сохранения карты и измерений в файл или File > Clear All Measurements (Файл — Очистить все измерения) для
очистки карты и продолжения нанесения измерений на карту.

ПРИМЕЧАНИЕ. Чтобы добавить измерения в новое место карты с привязкой к местности при активном
приемнике GPS, необходимо физически переместиться на это место. Если необходимо нанести измерения в
точке, отличной от текущего положения GPS, отключите GPS перед нанесением измерения.

ПРИМЕЧАНИЕ. Для перемещения значков измерения на карте нажмите кнопку перемещения результатов

( ). Щелкните на измерении и переместите его в новое место.

Повторное выполнение измерений в приложении RSA Map

Функция повторного выполнения измерений позволяет автоматически наносить на карту отдельные измерения с
заданным интервалом или при изменении местоположения GPS. Для выполнения повторных измерений необходимо
включить и задать привязку GPS. При этом следует использовать карту с привязкой к местности.

ПРИМЕЧАНИЕ. Приложение RSA Map наносит на карту только результаты завершенных измерений. Если
заданный временной интервал оказывается меньше, чем требуется для проведения измерения, RSA Map
игнорирует его и продолжает наносить на карту получаемые результаты до тех пор, пока не закончится сбор
данных. Например, если для проведения измерения прибору требуется 20 секунд, а установленный временной
интервал равен 10 секундам, прибор выполняет измерение и привязывает их к карте в течение всех 20 секунд.

1. Задайте параметры измерений
(частоту, полосу пропускания и т. п.) в
приложении SPECMON.

2. Выберите Tools > RSA Map
(Инструменты — RSA Map) для
возврата в приложение RSA Map.

3. Активируйте GPS, как описано выше.

4. Коснитесь кнопки «Повторное
измерение».
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5. При прикосновении к кнопке
«Настройки» открывается окно
настроек.

6. Задайте тип интервала измерений
(время или расстояние между
положениями измерения).

7. Коснитесь кнопки Done (Готово).

8. Для запуска повторных измерений
коснитесь карты в любой точке.
Прибор добавляет результаты
измерений на карту в том месте,
которое в этот момент определяется
системой GPS.

Прибор будет выполнять повторные
измерения в зависимости от времени
или расстояния, указанных на вкладке

(Настройки) > Repeat Measurement
(Повторные измерения).
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9. Коснитесь карты, чтобы остановить
измерения.

10. Коснитесь кнопки «Единичное
измерение» или значков выбора,
чтобы выйти из режима измерений с
нанесением на карту.

ПРИМЕЧАНИЕ. На карте можно разместить не более 200 результатов измерений. При повторных измерениях,
если прибор достигает этого предела, кратковременно отображается сообщение, а измерения и карта
автоматически сохраняются в текущую папку сохранения результатов, затем карта очищается, и RSA Map
может снова наносить на нее результаты измерений.

Значки измерений RSA Map

Для обозначения измерений, выполненных в конкретном месте, приложение RSA Map использует систему
значков. Над значками измерений можно выполнять различные действия, включая просмотр обозначаемых
значком результатов измерений, перемещение и удаление значка, а также прикрепление к нему стрелки,
указывающей направление проведения измерений. Более подробные сведения содержатся в следующих разделах
и интерактивной справке по RSA Map.

Просмотр и удаление результатов измерений, помеченных значками

Чтобы просмотреть или удалить результаты измерений, помеченные значками измерений RSA Map, выполните
приведенные ниже действия.

1. Коснитесь кнопки RSA Map.
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2. Коснитесь значка измерения, чтобы
открыть диалоговое окно Map
Measurements (Нанесение измерений
на карту).

3. Коснитесь в списке интересующего
измерения.

4. Коснитесь кнопки Open Measurement
(Открыть измерение), чтобы открыть
экран с данными выбранного
измерения. Выберите Tools >
RSA Map (Инструменты — RSA Map)
для возврата в окно RSA Map.
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5. Коснитесь кнопки Delete Measurement
(Удалить измерение), чтобы
удалить выбранное измерение.
Если требуется удалить несколько
измерений, повторите процедуру
удаления измерений несколько раз.

6. Коснитесь кнопки OK, чтобы закрыть
диалоговое окно.

ПРИМЕЧАНИЕ. Чтобы удалить с карты значки всех измерений, выберите пункты меню File > Clear All
Measurements (Файл — Удалить все измерения).

Изображение стрелки, указывающей азимут (направление) измерения

Функция изображения азимута RSA Map позволяет с помощью стрелки на нанесенном на карту измерении указать
направление, в котором была обращена антенна при выполнении измерения.

1. Коснитесь кнопки «Изменить азимут».

2. Коснитесь и перетащите центр
значка измерения в том направлении,
куда при выполнении измерения
была повернута антенна. RSA Map
изобразит стрелку, соответственно
направленную от значка измерения.
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В области пиктограмм измерений
отображается направление стрелки.
На экране отображаются истинный и
магнитный азимуты. При изменении
направления стрелки в области
пиктограмм отображается значение
угла для точного задания направления.
Отображаемая информация зависит от
типа карты (с привязкой к местности или
изображение). В примере представлена
карта с привязкой к местности.

3. Чтобы изменить направление стрелки,
проведите новую линию. RSA Map
заменит существующую стрелку на
стрелку другого направления.

Изменить направление стрелки можно
также путем прикосновения к измерению,
выбора в окне Map Measurements
(Нанесение измерений на карту) пункта
Change Azimuth (Изменить азимут) и
ввода значения магнитного азимута для
результата.

4. Для изменения стиля линии азимута
выберите View > Azimuth line style –
Line (Вид — Стиль линии азимута —
Линия) или Azimuth line style – Arrow
(Стиль линии азимута — Стрелка).

Удаление стрелки измерения азимута

1. Коснитесь кнопки RSA Map.

2. Коснитесь один раз значка измерения
с указательной стрелкой, которую
требуется удалить. RSA Map откроет
диалоговое окно Map Measurements
(Нанесение измерений на карту).
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3. Коснитесь названия измерения с
указательной стрелкой, которую
требуется удалить.

4. Коснитесь кнопки Delete Azimuth
(Удалить стрелку).

5. Коснитесь кнопки OK. RSA Map
закрывает диалоговое окно и удаляет
указательную стрелку.

Сохранение результатов измерений

RSA Map позволяет сохранять измерения в файл. Сохраненные результаты можно также открыть для просмотра.
RSA Map сохраняет результаты в формате архива zip. В сохраненных результатах содержится несколько типов
файлов:

файлы данных измерений (экспортированные результаты);

файл карты, использовавшейся для измерений;

файл KMZ Google Планета Земля;

файлы результатов, доступные для просмотра (файлы кривых и настроек);

MapInfo-совместимые файлы MIF/MID.

Подробные сведения о содержании архивов сохраненных данных см. в справке RSA Map.

Для сохранения результатов измерений:

1. Выберите File > Save As (Файл —
Сохранить как)
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2. Укажите путь к папке сохранения и
имя файла.

3. Для сохранения результатов выберите
Save (Сохранить).

Вызов результатов измерений

Для вызова сохраненных результатов измерений выполните приведенные ниже действия.

1. Выберите пункты меню File > Recall
(Файл > Вызвать).

2. Укажите путь к папке сохранения и
имя файла.

3. Для сохранения результатов выберите
Save (Сохранить).
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RSA Map загрузит содержимое вызванного
архива с результатами измерений.

Улучшенные методики
В настоящем разделе описаны усовершенствованные рабочие методики. Примеры практического применения см. в
руководстве SPECMON3 Real-Time Spectrum Analyzers and SPECMON6 Real-Time Spectrum Analyzers Application
Examples Manual (Стандартные примеры применения анализаторов спектра в реальном масштабе времени серии
SPECMON3 и SPECMON6).

Настройка запусков

Помимо синхронизации по уровню мощности, линейной синхронизации, синхронизации по рант-импульсу и внешней
синхронизации, эти анализаторы обеспечивают синхронизацию в частотной области и синхронизацию по фронту
частоты в реальном масштабе времени (опция 52). В качестве опорной точки времени для непрерывной регистрации
сигнала используются события синхронизации. Это позволяет анализатору сигнала сохранять сведения как об
интервале до запуска, так и об интервале после запуска.

В анализаторе имеется два режима синхронизации:

Режим Free Run (Без синхронизации). В режиме без синхронизации прибор запускает регистрацию без учета
любых условий синхронизации. Это быстрый и простой способ просматривать сигналы. Режим без синхронизации
обычно отвечает требованиям экрана Spectrum (Спектр), если нет необходимости указывать точное время
регистрации данных.

Режим Triggered (С синхронизацией). В режиме Triggered (С синхронизацией) прибор запускает регистрацию
данных, когда распознается событие синхронизации. Условия, которые задает событие синхронизации, зависят
от выбранного источника синхронизации. Имеется несколько вариантов источников для выбора сигнала,
использующегося при мониторинге событий синхронизации.

После выбора режима с синхронизацией следует выбрать источник синхронизации. Источниками синхронизации
являются:
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Вход радиосигнала

Вход сигнала синхронизации

2-ой вход сигнала синхронизации

Вход со стробированием

Линейный вход

После выбора источника синхронизации можно задать дополнительные параметры, чтобы указать событие
синхронизации. Если в качестве источника синхронизации указан вход радиосигнала, то можно выбрать любой из
двух типов синхронизации:

Синхронизация по плотности DPX. Данный тип синхронизации позволяет прибору захватывать любой,
видимый на экране DPX сигнал, в том числе и трудноразличимые сигналы, скрывающиеся за другими, имеющими
более высокую амплитуду или более высокую частоту следования. Используя функцию Trigger On This™
(синхронизация по ...), пользователь может обвести рамкой интересующую его область на графике, установить порог
плотности, и прибор будет осуществлять синхронизацию при превышении измеренным значением плотности
этого порога.

Синхронизация по временным параметрам. Синхронизация по временным параметрам позволяет
запускать прибор на основе переходов сигнала во времени. Временные условия можно использовать для основных
типов синхронизации. Например, если выбрать тип Power (мощность) и установить запуск по нарастающему фронту,
временные условия позволяют отбирать события по нарастающему фронту исходя из того, сколько времени
уровень сигнала остается высоким после превышения им порога синхронизации. Пользователь может задавать
синхронизацию только по импульсам, длительность которых превышает заданный период времени или, наоборот,
не превышает его. Настройка параметров вкладки Time Qualified (временные параметры) может быть выполнена
таким образом, чтобы принимались только импульсы шириной, помещающейся между двумя заданными значениями
или, наоборот, не попадающие между этими двумя значениями.

Также можно определить временные условия для событий синхронизации Frequency Mask (частотная маска), DPX
Density (плотность DPX) и Runt (рант-импульс). При каждом типе синхронизации прибор находит все события,
удовлетворяющие основным критериям синхронизации, после чего производит их тестирование относительно
заданных временных параметров.

Синхронизация по фронту частоты. При синхронизации по фронту частоты прибор запускается на основании
характеристик сигнала во временной области. Данные на входе сравниваются с выбранным пользователем
уровнем в Гц. Синхронизация по фронту частоты аналогична синхронизации по мощности, за исключением
того, что необходимо дополнительно установить порог мощности во избежание срабатывания при флуктуациях
кажущейся частоты, возникающих при низкой амплитуде. Можно выбрать полосу пропускания во временной области
и синхронизацию по нарастающему или ниспадающему фронту сигнала.

Синхронизация по частотной маске. Синхронизация по частотной маске позволяет выполнять синхронизацию
прибора, когда сигнал в частотной области нарушает маску. Можно нарисовать маску, которая будет генерировать
событие синхронизации, чтобы задать условия в пределах полосы пропускания в реальном масштабе времени. Она
позволит выполнять синхронизацию по слабым сигналам при наличии сильных сигналов. Эта синхронизация также
годится для регистрации периодически появляющихся сигналов.

Синхронизация по мощности. При синхронизации по мощности прибор запускается на основании
характеристик сигнала во временной области. Данные на входе сравниваются с выбранным пользователем
уровнем в дБм. Можно выбрать полосу пропускания во временной области и синхронизацию по нарастающему или
ниспадающему фронту сигнала.
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Синхронизация по огибающей. Синхронизация по огибающей определяет событие синхронизации по
амплитуде импульса, пересекающей первый пороговый уровень, но не пересекающей второй пороговый уровень до
повторного пересечения первого.

Кроме задания события синхронизации можно задать следующие параметры, выбрав соответствующую вкладку в
панели управления синхронизацией:

Параметры Position (положение) и Delay (задержка), которые определяют, где произойдет синхронизация
внутри записи зарегистрированных данных, и будет ли задержка синхронизации в течение определенного
периода времени.

Может ли по единичному событию быть выполнена синхронизация всего свип-сигнала или каждый участок
свип-сигнала требует отдельного события синхронизации в развернутом режиме регистрации.

Доступ к параметрам синхронизации

1. Щелкните кнопку Trig (Запуск), чтобы
открыть панель управления Trigger
(Синхронизация).

2. Ниже показаны действия для задания
параметров синхронизации, для
чего следует щелкнуть одну из
вкладок в панели управления Trigger
(Синхронизация).

3. Для задания параметров, которые
определяют события синхронизации,
используйте вкладку Event (Событие).
Параметры изменяются в зависимости
от выбора источника (Source) и типа
(Type) синхронизации.

4. Используйте вкладку Time Qualified
(временные параметры) для
установки параметров, определяющих
события синхронизации на основе их
длительности.
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5. Используйте вкладку Advanced
(дополнительно) для установки
параметров положения запуска и
настройки выдержки.

6. Используйте вкладку Actions
(действия) для установки параметров
для сохранения по функции
синхронизации. Сохранение по
функции синхронизации позволяет
сохранять файл регистрируемых
данных и (или) осуществлять
экранную регистрацию, когда
происходит событие синхронизации.

Совет

Другие способы получения доступа к панели управления Trigger (Синхронизация):

Нажмите кнопку Trigger (Синхронизация) на передней панели.

Выберите пункт Trigger. (Триггер) в меню Setup (Настройка).

Настройка синхронизации по плотности DPX

Синхронизация по плотности DPX позволяет регистрировать нестационарные сигналы, частично скрытые другими
сигналами, имеющими более высокую амплитуду или частоту следования. В случае, если удастся их различить на
точечном изображении DPX, по ним можно осуществлять синхронизацию. Для выбора зоны интереса на экране и
измерения ее текущей плотности используется область измерений плотности DPX. Пользователь устанавливает
пороговое значение плотности, а прибор осуществляет синхронизацию при превышении измеренным значением
плотности этого порога.

Самый быстрый способ настройки синхронизации по плотности DPX – щелчок правой кнопкой мыши
представляющего интерес сигнала на графике DPX или нажатие на поверхность экрана и удержание в таком
положении пальца в течение не менее одной секунды. При этом на экране высвечивается меню. Выберите пункт
Trigger On This (синхронизация по ...). Это действие выполняет несколько задач:

Размещает окно измерения плотности в месте, где произведен щелчок.

Устанавливает для измерительного окна размеры по умолчанию.

Измеряет в пределах измерительного окна среднюю плотность

Устанавливает для режима Trigger (синхронизация) параметр Triggered (синхронизировано)

Выбирает тип «Higher» (выше) для синхронизации по плотности DPX

Устанавливает порог синхронизации для значения плотности несколько ниже текущего измеряемого значения

Запускает процесс регистрации
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Чтобы оптимизировать настройки синхронизации по плотности DPX для конкретных сигналов, откройте панель
управления Trigger (синхронизация). При помощи элементов управления отрегулируйте полярность сравнения
порога синхронизации (Higher (выше) и Lower (ниже)), значение Threshold (порог), размер и местоположение
измерительного окна. При помощи настроек Frequency (частота) и Amplitude (амплитуда) определите
местоположение центра окна и задайте значения отступа от центра для установки ширины и высоты измерительного
окна.

Для событий, частично скрытых более сильными сигналами, зачастую требуется регулировать пороговое значение
плотности Threshold (порог), опираясь на измерения плотности представляющего интерес события и затеняющего
сигнала. Например, если плотность фонового цвета, характеризующего только один, более сильный сигнал,
составляет 7 %, а измеренная суммарная плотность обоих сигналов составляет 9 %, следует установить значение
Threshold (порог) равным 8 %.

Если ожидается, что сигнал будет непрерывным, и нужно регистрировать события его скачкообразного перехода на
другую частоту или на более низкую амплитуду, расположите измерительное окно Density (плотность) так, чтобы
оно охватывало пик сигнала, выберите условие Lower (ниже) для элемента управления Density (плотность) и
задайте значение Threshold (порог) равным 100 %. Прибор выполнит синхронизацию, когда сигнал исчезнет
из измерительного окна.

Совет. Измеренное значение плотности является средним по всем плотностям, определяемым столбцами
пикселей в окне. Если измерительное окно шире пика немодулированного сигнала, измеренное значение плотности
будет ниже 100 %. Чтобы получить показание, равное 100 %, можно расширить пик путем увеличения разрешения по
частоте или сузить окно, так чтобы выше или ниже окна исчезли цветные пиксели. Кривая сигнала должна входить в
окно с левой стороны и выходить с правой. Она не должна пересекать нижний край окна.

Создание частотной маски

Для создания частотной маски используйте Mask Editor (Редактор масок). Маска – это набор точек, определяемый
частотой и амплитудой сигнала. Получить доступ к редактору масок можно с панели управления Trigger
(Синхронизация). (Эта процедура использует экран Spectrum (Спектр).)
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Частотную маску Frequency Mask (частотная маска) можно создать либо вручную, либо при помощи метода Auto
Draw (автоматическое построение). Ниже описана процедура ее ручного создания. Процедура применения метода
Auto Draw (автоматическое построение) описана в разделе Mask Editor (Frequency Mask Trigger) (редактор масок
(синхронизация по частотной маске)) электронной справки.

1. Щелкните кнопку Trig (Запуск), чтобы
открыть панель управления Trigger
(Синхронизация).

2. В панели управления выберите
вкладку Event (Событие).

3. В поле Source (Источник)
выберите значение RF Input
(Вход радиосигнала).

4. В поле Type (Тип) выберите значение
Frequency Mask (Частотная маска).

5. Чтобы открыть редактор масок,
щелкните кнопку Mask Editor
(Редактор масок).

Редактор масок открывается с
осциллограммами экрана Spectrum
(Спектр) в графическом окне.

6. В панели инструментов щелкните
кнопку New (Создать). Это действие
удаляет существующую маску, затем
по умолчанию создает 6-точечную
маску.
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7. Щелкните любую точку в маске, чтобы
выбрать ее.

В графическом окне подсвечиваются
частота и амплитуда сигнала в
выбранной точке.

8. Отредактируйте точку, выполнив одно
из следующих действий:

Перетащите точку с помощью
мыши.

Введите в таблице частоту и
амплитуду.

Настройте амплитуду с помощью
кнопок со стрелками ВВЕРХ или
ВНИЗ, а частоту – с помощью
кнопок со стрелками ВЛЕВО или
ВПРАВО.

Советы

Щелкните кнопку Auto draw (автоматическое построение), чтобы автоматически построить маску по сигналу
Reference (опорный сигнал).

Чтобы добавить новую точку, щелкните на экране дисплея.

Щелкните параметр Add Points (Добавление точек), затем щелкните график, чтобы добавить в нем новую точку.

Щелкните Next (Далее), чтобы выбрать следующую точку на графике.

Щелкните кнопку X (кнопка удаления), чтобы удалить выбранную точку маски.

Щелкните кнопку Save (Сохранить), чтобы сохранить файл маски и продолжить работу с редактором масок.

Щелкните кнопку Open (Открыть), чтобы загрузить и отредактировать ранее сохраненный файл маски.

Определение условий синхронизации

После настройки маски можно выбрать, будет ли выполняться синхронизация при наличии и при отсутствии
нарушений маски.
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1. Выберите условие.

Возможные варианты описаны ниже.
(См. таблицу 7.) Значки в нижней
части панели управления показывают,
что считать правдой, а что ложью.

2. Щелкните параметр Triggered (С
синхронизацией).

Прибор будет запускаться, когда
встретит условия синхронизации.

Таблица 7: Нарушения синхронизации

Нарушение Описание

T Прибор включается в том случае, когда сигнал нарушает маску (над линией).

F Прибор включается в том случае, когда у сигнала нет точек в маске.

T > F Один переход определяет событие синхронизации. Сигнал должен выходить из
маски (нарушение отсутствует) после пребывания внутри маски (нарушение).

F > T Один переход определяет событие синхронизации. Сигнал должен входить в маску
после пребывания вне маски.

T > F > T Два перехода определяют событие синхронизации. Сигнал должен начинаться
внутри маски, выйти из маски наружу и затем снова вернуться в маску.

F > T > F Два перехода определяют событие синхронизации. Сигнал должен начинаться вне
маски (нарушение отсутствует), войти в маску, а затем снова выйти из маски.

Управление параметрами регистрации

Когда открыты два или более экранов, один экран управляет системой регистрации данных. Требования к
регистрации данных для выбранного экрана устанавливают аппаратные параметры регистрации. Несмотря на то
что параметры регистрации для выбранного экрана оптимизированы, они могут быть не идеальными для других
экранов. В этом случае, на других экранах, возможно, не удастся поддерживать оптимальные характеристики, и
поэтому, вполне вероятно, не удастся выдавать результаты. (Это также происходит при анализе восстановленных
данных: после измерений делается попытка предоставить результаты, но они, возможно, могут не соответствовать
всем своим параметрам.)

Щелкнув в любом месте экрана, можно указать, какой экран управляет аппаратными параметрами регистрации. При
наличии нескольких экранов выделенный экран управляет аппаратными параметрами регистрации.

SPECMON3 и SPECMON6 — краткое руководство по эксплуатации 69



Работа

В этом примере имеется два экрана,
экран Spectrum (Спектр) и экран DPX
Spectrum (Спектр DPX). Подсвеченная
строка заголовка на экране DPX Spectrum
(Спектр DPX) означает, что он является
выбранным экраном.

Значок в виде галочки в левом верхнем
углу экрана означает, что аппаратура для
регистрации данных оптимизирована для
отображения спектра.

Некоторые экраны не управляют оборудованием для регистрации данных. На этих экранах просто отображаются
полученные данные. Некоторые экраны совместно используют ряд параметров. Если любой из этих экранов в таком
семействе управляет аппаратурой для регистрации данных, то параметры регистрации оптимизированы для
всех экранов в этом семействе.

Измерения с противоречивыми требованиями к регистрации данных

Анализаторы позволяют открыть любую комбинацию измерений. Если выбрать интересующие вас экраны, прибор
автоматически установит соответствующие параметры анализа и регистрации.

Если измерения накладывают противоречивые требования на параметры регистрации, приоритет имеет экран,
выбранный в данный момент. В следующем примере показываются несовместимые параметры измерений, когда
для одного экрана требуются данные в реальном масштабе времени (например, измерения зависимости амплитуды
от времени), в то время как для другого экрана необходимы развернутые данные (например, график спектра в
очень широком интервале).

1. Нажмите кнопку Preset
(Предварительная установка) на
передней панели, чтобы установить в
приборе параметры по умолчанию.

2. Настройте прибор на частоту вашего
сигнала, затем задайте интервал.

3. Щелкните значок Displays (экраны),
чтобы открыть диалоговое окно Select
Displays (выбор экранов).
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4. Выберите папку General Signal Viewing
(Общий просмотр сигнала).

5. Выберите значок Amplitude vs Time
(Зависимость амплитуды от времени).

6. Щелкните кнопку Add (Добавить),
чтобы добавить значок в список
Selected Displays (Выбранные
экраны).

ПРИМЕЧАНИЕ. Добавьте экран
Spectrum (Спектр), если он еще
отсутствует в списке Selected Displays
(Выбранные экраны).

7. Нажмите кнопку OK, чтобы
подтвердить внесенные изменения и
закрыть диалоговое окно.

8. Увеличьте интервал на экране
Spectrum (Спектр) до 200 МГц.

Поскольку экран Spectrum
(Спектр) является выбранным
экраном, параметры регистрации
настраиваются автоматически, чтоб
соответствовать требованиям экрана.
Интервал 200 МГц превышает полосу
пропускания прибора в реальном
масштабе времени. В результате
прибор перейдет в режим развертки.

9. Взгляните на строку состояния.
Значение «Swept» (С
разверткой) показывает, когда
зарегистрированные данные
развертываются.

Когда регистрации находятся в
состоянии «Real Time» (Реальный
масштаб времени), обычно
выполняются все измерения.
Если регистрации развертываются, то
измерение может выполняться только
на выбранном экране.
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10. Щелкните экран Amplitude vs Time
(Зависимость амплитуды от времени),
чтобы сделать его активным экраном.

Регистрация снова переключается
в реальный масштаб времени,
поскольку для выбранного экрана
необходимо использовать реальное
время. Теперь данные подходят
для экрана Amplitude vs Time
(Зависимость амплитуды от времени),
но не содержат полный диапазон
частот, необходимый для экрана
Spectrum (Спектр).

В этом случае отображение спектра
выполнить невозможно.
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11. Уменьшите интервал на экране
Spectrum (Спектр) до 25 МГц. Теперь
регистрации снова выполняются в
реальном масштабе времени.

12. Проверьте данные, выводимые в
строке состояния, чтобы убедиться,
что регистрация выполняется в
реальном масштабе времени.

Теперь можно запустить оба экрана.

Поиск сигналов

Анализаторы позволяют выполнять поиск изменений уровня мощности на результирующей кривой экрана
спектра. Можно идентифицировать совпадения, пересекающие некоторый уровень мощности, или создавать
маску, устанавливающую пределы уровня мощности и диапазона частот. Можно выбирать тип искомой кривой и
устанавливать действие, предпринимаемое в случае совпадения при поиске. Можно также искать результаты
Pass/Fail (Пройден/Сбой) для измерений Spurious (Паразитный сигнал) и Settling Time (Время установления), но
здесь мы будем использовать пример с кривой Spectrum (Спектр).

Чтобы найти кривую:
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1. Откройте экран Spectrum (Спектр) или
выберите экран Spectrum (Спектр),
если он уже открыт.

2. Выберите Tools (Сервис) > Search
(Поиск).

3. Установите флажок Enable Search
(Включить функцию поиска).

4. Выберите кривую для поиска в
раскрывающемся списке Search in
(Искать в).

5. Убедитесь, что выбрана кривая,
выбранная в списке Search in (Искать
в), и что установлен флажок Show
(Показать).
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6. Укажите, что следует искать, выбрав
соответствующий вариант в списке
Search for (Искать).

Чтобы найти фрагмент сигнала с
уровнем выше или ниже заданного,
выберите is greater than (больше) или
is less than (меньше).

Чтобы найти фрагмент сигнала,
уровень которого меняется с
изменением частоты, выберите is
outside mask (вне области маски)
или is inside mask (в области маски).
Чтобы указать предельные значения
для маски поиска, нажмите кнопку
Edit limits (Изменить предельные
значения).

Оранжевая область в окне графика
показывает уровни, соответствующие
искомому сигналу.

Экран с выбранным критерием поиска «больше».

Экран с выбранным критерием поиска «вне маски».

SPECMON3 и SPECMON6 — краткое руководство по эксплуатации 75



Работа

7. Откройте вкладку Actions (Действия),
чтобы задать действия, которые
должен предпринять анализатор в
случае совпадения.

В зависимости от режима работы
анализатор может предпринять до
пяти действий. В режиме Run (Запуск)
анализатор может подать звуковой
сигнал, остановить регистрацию
данных, сохранить данные
регистрации, сохранить данные
кривой и сохранить изображение
экрана. В режиме Replay (Повторное
воспроизведение) он может подать
звуковой сигнал и остановить анализ.

8. Выберите нужное действие, чтобы
анализатор предпринял его в случае
совпадения.

Можно выбрать любое сочетание
действий. Если выбрать все действия,
все они будут выполняться при
обнаружении соответствия (в режиме
Run (Пуск)).

9. Чтобы убрать панель управления
Search (Поиск), нажмите кнопку
закрытия.

10. Чтобы начать поиск, нажмите кнопку
RUN (Пуск).

При обнаружении соответствия
во входящем сигнале на графике
появляются красные линии. Чтобы
начать поиск в зарегистрированных
данных, нажмите на панели
инструментов кнопку Replay
(Воспроизведение).
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Использование таблиц коррекции

Анализаторы позволяют корректировать изображение сигнала и результаты измерений для учета коэффициента
усиления и потерь во внешнем оборудовании. Предусмотрена возможность задания отдельного коэффициента
усиления или использования таблицы внешних потерь для подгонки отношения усиление/потери на базе частоты.

Для определения поправок «усиление/потери» во внешнем оборудовании:

1. Нажмите кнопку значка Amplitude
(амплитуда), чтобы отобразить панель
управления Amplitude (амплитуда).

2. Выберите вкладку External Gain/Loss
Correction (поправка на внешнее
усиление/потери).

3. Чтобы использовать постоянный
коэффициент коррекции, установите
флажок External Gain value
(Коэффициент усиления внешней
аппаратуры). Введите значение в
текстовое поле.

ПРИМЕЧАНИЕ. Можно ввести
как положительное, так и
отрицательное значение коэффициента
усиления. Положительное
значение соответствует
усилению. Отрицательное значение
соответствует потерям.
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4. Чтобы использовать таблицу для
коррекции данных с учетом значений
усиления или потерь, зависящих от
частоты, установите флажок External
Loss Tables (Таблицы внешних
потерь).

Можно одновременно использовать
три таблицы внешних потерь. Таким
образом, можно использовать
разные таблицы потерь для антенны,
предусилителя и кабелей.

5. Чтобы изменить содержание таблицы
внешних потерь, нажмите кнопку Edit
(Изменить) для таблицы, в которую
требуется внести изменения.

6. Внесите в таблицу изменения,
соответствующие параметрам потерь,
характерным для используемого
оборудования. По завершении
щелкните ОК.

ПРИМЕЧАНИЕ. В таблицу можно
вводить как положительные, так
и отрицательные значения. Но в
отличие от параметра External Gain
(Коэффициент усиления внешней
аппаратуры) положительные
значения соответствуют потерям, а
отрицательные — усилению.

Для получения подробных сведений
об использовании редактора таблиц
выберите Help (Справка) > User Manual
(Руководство пользователя) и найдите в
указателе External Loss Tables (Таблицы
внешних потерь).
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7. Можно изменить название любой
таблицы внешних потерь. Выберите
поле названия и введите новое
название.

Имейте в виду, что название —
это всего лишь метка. Оно не
связано с именем файла какой-либо
загруженной или сохраненной
таблицы.

8. Укажите, вносятся ли табличные
поправки во все регистрируемые
данные или только в кривые
на экранах Spectrum (спектр),
Spectrogram (спектрограмма),
Spurious (побочный канал) и Amplitude
vs Time (зависимость амплитуды от
времени).

Применяемые к данным поправки
выполняются в реальном времени
с помощью функции цифрового
фильтра прибора. Хотя эта функция
позволяет корректировать данные
для использования во всех типах
измерений, способность цифрового
фильтра применять поправки с
быстро меняющейся амплитудой в
малом диапазоне частот ограничена.
Примером таких условий может
служить переключение между
двумя антеннами. В этом случае
фильтры могут стать причиной
зацикливания поправок и привести к
получению плохо скорректированных
данных. Поэтому для отображения
спектрограмм, спектра, паразитных
колебаний и амплитуды в зависимости
от времени в приборе предусмотрена
только поправка кривых. Поправка
кривых аналогична поправкам,
применяемым в традиционных
спектральных анализаторах, и
должна применяться в случае
разрыва сигнала в таблице поправок
амплитуды/частоты.
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Принимая решение, вводить ли
поправки в данные выборки или
кривые, следует иметь в виду
следующее:

Если при регистрации данных
выборки включена процедура
введения поправок, запись этих
данных постоянно корректируется.
Сохраненные и вновь вызванные
зарегистрированные данные уже
содержат поправки. Поправки не
хранятся отдельно от исходных
данных; они вводятся в процессе
регистрации, изменяя значения
данных.

Поправки к кривым могут быть
внесены в любой момент, поскольку
они являются составной частью
процесса вычислений измеренных
значений. Если кнопка Replay
(повторное воспроизведение) активна
(и указана и включена внешняя
таблица потерь), нажатием на нее
вносятся поправки в кривую.

Имейте в виду, что если вызвать
зарегистрированные данные, которые
сохранялись с введенными в них
поправками, а затем применить кнопку
Replay (повторное воспроизведение)
с выбранными для кривой поправками
и включенной внешней таблицей
потерь, для расчета кривой
будут использоваться уже
откорректированные данные, и в
них дополнительно будут внесены
поправки к кривой. В результате
обычно получают некорректные
кривые.

9. После внесения изменений нажмите
кнопку закрытия, чтобы убрать панель
управления Amplitude (Амплитуда).

Использование демодуляции аудиосигнала

Анализаторы позволяют демодулировать звуковые сигналы и благодаря этому идентифицировать неизвестные
радиосигналы. Для этого из панели управления Settings (Настройки) графического экрана DPX Spectrum (Спектр
DPX) следует перейти на вкладку Audio Demod (Демодуляция звукового сигнала).
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Для демодуляции аудиосигнала:

1. Нажмите кнопку Displays (Экраны),
чтобы открыть диалоговое окно Select
Displays (Выбор экранов).

2. Выберите папку General Signal
Viewing (Общий просмотр сигнала).

3. Дважды щелкните значок DPX
Spectrum (Спектр DPX), чтобы
добавить этот экран в список Selected
Displays (Выбранные экраны).

4. Нажмите кнопку OK, чтобы закрыть
диалоговое окно. Откроется экран
DPX Spectrum (Спектр DPX).

5. При необходимости выберите пункт
Spectrum plot (График спектра) из
раскрывающегося списка.

6. Нажмите на передней панели кнопку
Settings (Настройки) для отображения
панели управления DPX Settings
(Настройки DPX).

7. Перейдите на вкладку Audio Demod
(Демодуляция аудиосигнала), чтобы
вывести на экран панель управления
Audio Demod (Демодуляция
аудиосигнала).
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8. Нажмите кнопку On (Вкл.), чтобы
включить функцию демодуляции
аудиосигнала.

9. Чтобы указать тип демодуляции,
нажмите кнопку AM (АМ) или FM (ЧМ).

ПРИМЕЧАНИЕ. Обратите внимание,
что кнопки AM (АМ) и FM (ЧМ)
предназначены только для выбора типа
демодуляции; они не позволяют задать
частотный диапазон.

10. При необходимости укажите
центральную частоту.

Частота приемника (частота для
демодуляции) задается с помощью
маркеров или элемента управления
частотой (кнопка Frequency (Частота)
на передней панели или элемент
управления Freq (Частота) на панели
инструментов). Чтобы указать способ
задания частоты приемника — с
помощью маркеров или элемента
управления частотой, используется
параметр Tune with (Настройка с
помощью).

11. Выберите в раскрывающемся списке
Tune with (Настройка с помощью) либо
маркер, либо элемент управления
частотой.

12. Если выбранный вами маркер
заблокирован (разблокированный
маркер виден на экране), нажмите
кнопку Markers значка Markers
(маркеры) на панели инструментов,
чтобы отобразить панель
инструментов Markers (маркеры).
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13. Нажмите кнопку Define (Задать) на
панели инструментов Marker (Маркер),
чтобы вывести на экран панель
управления Define Markers (Задание
маркеров).

14. Нажмите кнопку Add (Добавить),
чтобы добавить необходимые
маркеры.

15. Нажмите кнопкуSettings (Параметры),
чтобы вернуться к панели управления
Audio Demod (Демодуляция
аудиосигнала).

16. Задайте необходимую полосу
пропускания приемника, для чего
введите значение в поле Receiver BW
(Полоса пропускания приемника).
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17. Установите значение частоты
приемника.

Если для параметра Tune with
(Настройка с помощью) указан маркер,
перетащите маркер на необходимую
частоту. Скорректируйте положение
маркера с помощью ручки на передней
панели или колесика мыши. Если для
параметра Tune with (Настройка с
помощью) выбрано Frequency control
(Элемент управления частотой),
нажмите на передней панели кнопку
FREQ (Частота), а затем установите
частоту с помощью ручки на передней
панели или параметра Freq (частота)
на панели инструментов.

Частота приемника отображается как
Receiver Freq (Частота приемника)
между параметрами Tune with
(Настройка с помощью) и Receiver BW
(Полоса пропускания приемника).

18. Настройте значение параметра Audio
Gain (Усиление аудиосигнала) для
прослушивания демодулированного
сигнала. Обратите внимание, что
громкость звука зависит также от
настройки регулятора громкости
Windows.
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Технические характеристики

Технические характеристики SPECMON3 и SPECMON6
Этот раздел содержит описание гарантированных и механических характеристик анализаторов. Все
гарантированные характеристики помечены значком . Типичные технические характеристики приводятся для
удобства, но их значения не гарантируются изготовителем.

Пределы рабочих параметров, указанные в этих технических характеристиках, обеспечиваются при следующих
условиях:

Прибор должен быть откалиброван и настроен при температуре от +18 °C до +28 °C.

Прибор должен эксплуатироваться в условиях, когда температура окружающего воздуха, высота над уровнем
моря, относительная влажность и уровень вибраций находятся в пределах, приведенных в данных технических
характеристиках.

Прибор должен быть прогрет в течение по меньшей мере 20 минут.

Таблица 8: Частотные характеристики

Характеристика Описание

Опорная частота

Начальная погрешность при
калибровке

1 x 10-7 (после 10-минутного прогрева)

Выходной уровень опорной
частоты

>0 дБм

Входной уровень внешней
опорной частоты

От -10 до +6 дБм

Таблица 9: Радиочастотный вход

Характеристика Описание

РЧ КСВН Во время испытания центральная частота должна быть установлена в
пределах 200 МГц от любой тестовой частоты КСВН.

Предусилитель выключен,
ослабление РЧ-сигнала = 10 дБ

От 10 МГц до 3 ГГц < 1,6

От 3 до 6,2 ГГц < 1,8

Опция 01, предусилитель включен,
ослабление РЧ-сигнала = 10 дБ

От 10 МГц до 6,2 ГГц < 1,9
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Таблица 10: Амплитуда (за исключение ошибки рассогласования)

Характеристика Описание

Частотная характеристика (от 18 до 28 °C, ослабление = 10 дБ, предусилитель выключен)

От 10 до 32 МГц, диапазон
километровых волн

±0,7 дБ

От 10 МГц до 3 ГГц ±0,5 дБ

От 3 до 6,2 ГГц ±1,0 дБ (SPECMON6)

Таблица 11: Шумы и искажения

Характеристика Описание

Интермодуляционные
искажения 3-го порядка

< -77 дБн при 2,130 ГГц

Уровень каждого сигнала на РЧ-входе при -25 дБм, аттенюатор = 0,
разделение частот тонового сигнала 1 МГц, уровень опорного сигнала
= -20 дБ

Интермодуляционные искажения
3-го порядка

Типичное значение

От 10 кГц до 32 МГц, диапазон
километровых волн

< -75 дБн

От 9 кГц до 80 МГц < -71 дБн

От 80 МГц до 3 ГГц < -76 дБн

От 3 до 6,2 ГГц < -76 дБн (только SPECMON6)

Отображаемый усредненный уровень шумов (DANL), приведенный к полосе разрешения 1 Гц

Предусилитель выключен
(режим с минимизацией шумов)

Номинальное значение Типичное значение

От 1 до 100 Гц, диапазон
километровых волн

Не применимо -129 дБм/Гц

От 100 Гц до 2 кГц, диапазон
километровых волн

-128 дБм/Гц -131 дБм/Гц

От 2 Гц до 10 кГц, диапазон
километровых волн

-140 дБм/Гц -142 дБм/Гц

От 10 Гц до 32 МГц, диапазон
километровых волн

-149 дБм/Гц -152 дБм/Гц

От 9 кГц до 1 МГц -108 дБм/Гц -111 дБм/Гц

От 1 до 30 МГц -136 дБм/Гц -139 дБм/Гц

От 30 МГц до 2 ГГц -154 дБм/Гц -157 дБм/Гц

От 2 до 3 ГГц -153 дБм/Гц -156 дБм/Гц

От 3 до 4 ГГц (только
SPECMON6)

-151 дБм/Гц -154 дБм/Гц

От 4 до 6,2 ГГц (только
SPECMON6)

-149 дБм/Гц -152 дБм/Гц

Предусилитель включен (опция
01) (режим с минимизацией
шумов)

Номинальное значение Типичное значение
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Таблица 11: Шумы и искажения (прод.)

Характеристика Описание

От 1 до 10 МГц -158 дБм/Гц -160 дБм/Гц

От 10 МГц до 2 ГГц -165 дБм/Гц -167 дБм/Гц

От 2 до 3 ГГц -163 дБм/Гц -165 дБм/Гц

От 3 до 6,2 ГГц (только
SPECMON6)

-161 дБм/Гц -163 дБм/Гц

Таблица 12: Отклик канала 1

Характеристика Описание

Неравномерность амплитудной характеристики

Полоса пропускания ≤ 300 кГц 2,
центр. частота = 200 МГц

±0,1 дБ

300 кГц < Полоса пропускания
≤ 10 МГц 2, центр. частота =
200 МГц

±0,2 дБ

10 МГц < Полоса пропускания
≤ 20 МГц 2, центр. частота =
200 МГц

±0,4 дБ

20 МГц < Полоса пропускания
≤ 25/40 МГц 2, центр. частота =
200 МГц

±0,4 дБ

40 МГц < Полоса пропускания
≤ 85 МГц 2, центр. частота =
200 МГц

±0,5 дБ

Линейность фазы

Пол. проп. ≤ 300 кГц 2, центр.
частота = 200 МГц (типичное
значение)

±0,1°

300 кГц < пол. проп. ≤ 10 МГц 2,
центр. частота = 200 МГц

±0,5°

10 МГц < пол. проп. ≤ 20 МГц 2,
центр. частота = 200 МГц

±0,75°

20 МГц < пол. проп. ≤
25/40 МГц 2, центр. частота =
200 МГц

±0,75°

40 МГц < пол. проп. ≤ 85 МГц 2,
центр. частота = 200 МГц

±2 °

1 Полоса пропускания, использованная в этой таблице, является полосой пропускания канала.
2 После калибровки и согласования.
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Таблица 13: Избирательность по побочным каналам

Характеристика Описание

Остаточный отклик

От 200 МГц до 3 ГГц

От 3 до 6,2 ГГц (только
SPECMON6)

-92 дБм

-92 дБм

Избирательность по побочным
каналам по отношению к сигналу
(подавление зеркального канала)

< -75 дБн (от 100 Гц до <30 МГц, опорный уровень = -30 дБм, аттенюатор =
10 дБ, уровень РЧ-входа = -30 дБм, ширина полосы пропускания разрешения
= 10 Гц)

< –80 дБн (от 30 МГц до 3 ГГц, опорный уровень = -30 дБм, аттенюатор =
10 дБ, уровень РЧ-входа = -30 дБм, ширина полосы пропускания разрешения
= 10 Гц)

< -80 дБн (от 3 ГГц до 6,2 МГц, опорный уровень = -30 дБм, аттенюатор =
10 дБ, уровень РЧ-входа = -30 дБм, ширина полосы пропускания разрешения
= 10 Гц)

Диапазон ≤ 25 МГц,
диапазоны развертки > 25 МГц

Для опции 40/85 1

25 МГц < диапазон ≤ 85 МГц
Избирательность по побочным

каналам по отношению к сигналу
(смещение 400 МГц)

Номинальное
значение

Типичное
значение Номинальное

значение

Типичное
значение

От 1 до 32 МГц, диапазон
километровых волн

-71 дБн -75 дБн Не применимо Не применимо

От 30 МГц до 3 ГГц -73 дБн -78 дБн -73 дБн -75 дБн

От 3 до 6,2 ГГц (только
SPECMON6)

-73 дБн -78 дБн -73 дБн -75 дБн

Диапазон ≤ 25 МГц,
диапазоны развертки > 25 МГц

Для опции 40/85 1

25 МГц < диапазон ≤ 85 МГц
Избирательность по побочным
каналам по отношению к сигналу
(смещение от 10 кГц до 400 МГц)

Номинальное
значение

Типичное
значение Номинальное

значение

Типичное
значение

От 1 до 32 МГц, диапазон
километровых волн

Не применимо -71 дБн Не применимо Не применимо

От 30 МГц до 3 ГГц Не применимо -73 дБн Не применимо -73 дБн

От 3 до 6,2 ГГц (только
SPECMON6)

Не применимо -73 дБн Не применимо -73 дБн

1 С центральной частотой > 90 МГц для опции 40/85.

Таблица 14: Физические характеристики

Характеристика Описание

Размеры

Ширина (с убранными ручками) 473 мм

Высота (с опорами) 282 мм

Длина 531 мм

Масса (без опций)
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Таблица 14: Физические характеристики (прод.)

Характеристика Описание

Нетто 25,7 кг

В упаковке 35,6 кг
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